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1 INTRODUCTION 1.1 OVERVIEW 1.1.1 DESCRIPTION

The Remote RTD Module (RRTD) provides additional RTD temperature metering capabilities for GE Multilin relays such as
the 369 Motor Management Relay.

The RRTD module is a ‘black box’ which monitors up to 12 RTDs and can be polled for information. All RRTD setpoint pro-
gramming is accomplished via the 369 over the serial communication link or by other devices using the Modbus RTU proto-
col. Communications connections are over a shielded twisted pair RS485 connection or via the fiber optic port.

The RRTD module has been designed to be mounted close the motor to facilitate reduced length of RTD wiring. A 369
Motor Management Relay can then monitor the RTDs from a remote location and use this temperature information for pro-
tection/metering purposes.

The RRTD has three RS485 ports. The Modbus RTU protocol is standard to all ports. The Fiber Optic port and Profibus
protocol are optional features of the RRTD.

Optional output relays, digital inputs, and analog outputs are also provided (see pages 2–5 to 2–6 for additional details).
These features allow for addition control and provide stand alone overtemperature protection. The RTDPC program is used
to program setpoints and monitor actual values if the RRTD is operated as stand alone. A Quick Panel display may be used
to monitor temperatures.

RRTD options are available when ordering the relay or as upgrades to the relay in the field. Field upgrades are via an
option enabling passcode available from GE Multilin, which is unique to each relay and option.

1.1.2 ORDERING

Select the basic model and the desired features from the selection guide below:

Notes: The control power (HI or LO) must be specified with all orders. If a feature is not required, a 0 must be
placed in the order code. All order codes have 9 or 10 digits.

Examples: RRTD-HI-IO-0 RRTD with HI voltage control power and IO option
RRTD-LO-0-F RRTD with LO voltage control power and fiber optic port

Location: GE Multilin
215 Anderson Avenue
Markham, Ontario
Canada L6E 1B3
Tel: (905) 294-6222, 1-800-547-8629 (North America)
Fax: (905) 201-2098
Web Page: http://www.GEindustrial.com/multilin; e-mail: info.multilin@indsys.ge.com

RRTD S S S

RRTD | | | Base unit

HI | | 50 to 300 V DC / 40 to 265 V AC control power

LO | | 20 to 60 V DC / 20 to 48 VAC control power

IO | Optional Input and Output

0 | No optional Input and Output

F Optional Fiber Optic port

0 No optional Fiber Optic port
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1.1.3 REVISION HISTORY

1.1.4 FUNCTIONAL SUMMARY

Figure 1–1: FUNCTIONAL VIEW

Table 1–1: FIRMWARE REVISION HISTORY

REVISION DESCRIPTION OF CHANGES RELEASE DATE

59CMB110.000 Production Release October 15, 1999

59CMB120.000 Improvements to Channel 3 communications January 3, 2000

59CMB140.000 Improved method of downloading setpoint files February 16, 2000

59CMB151.000 Changes to communications October 18, 2002

Table 1–2: SOFTWARE REVISION HISTORY

REVISION DESCRIPTION OF CHANGES RELEASE DATE

1.10 Production Release October 15, 1999

1.20 PC software for new firmware January 3, 2000

1.40 Implemented refresh RRTD setpoints command February 16, 2000

1.51 Changes to Channel communications October 18, 2002

FIBER OPTIC DATA LINK (F)
For harsh environments

DIGITAL INPUTS
(IO)

Communications
(3)-RS485 Com Ports

ANALOG OUTPUT
(IO)

813701A5.CDR

CONTROL POWER
HI: 50-300VDC/40-265VAC
LO: 20-60VDC/20-48VAC

Customer Accessible
fuse

12 RTD INPUTS
field selectable type

4 OUTPUT RELAYS (IO)
Programmable alarm and
trip conditions activated
by programmable setpoints,
digital inputs and remote
communication control.
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1.1.5 LABEL DEFINITION

1. The RRTD order code at the time of leaving the factory.

2. The serial number of the RRTD.

3. The firmware that was installed in the RRTD when it left the factory. Note that this may no longer be the current firm-
ware as firmware may be upgraded in the field. The current firmware revision may be checked via the RTDPC pro-
gram.

4. Specifications for the output relay contacts.

5. Certifications the RRTD conforms with or has been approved to.

6. Factory installed options. These are based on the order code. Note that the RRTD may have had options upgraded in
the field. The Actual Values section of the RTDPC may be checked to verify this.

7. Control power ratings for the RRTD as ordered. Based on the HI/LO rating from the order code.

8. Pollution degree.

9. Overvoltage Category.

10. IP code.

11. Modification number for any factory ordered mods. Note that the RRTD may have had modifications added in the field.
The Actual Values section of the RTD PC may be checked to verify this.

12. Insulative voltage rating.

CEg

INPUT POWER:

MODEL: RRTD-HI-IO-F-0

MAXIMUM CONTACT RATING
250 VAC 8A RESISTIVE

1/4 HP 125 VAC 1/2 HP 250 VAC

SERIAL No: M59B01000745

FIRMWARE: 59CMB140.000

POLLUTION DEGREE: 2 IP CODE: 5OX

50-300 VDC

40-265 VAC

485mA MAX.

50/60Hz or DC
MOD:

INPUT & OUTPUT

FIBER OPTIC PORT

OPTIONS

INSULATIVE VOLTAGE: 2

NONEOVERVOLTAGE CATEGORY: II

1

7

2

8

3

9

4

10 11

5 6

12

UL

813350A3.CDR
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1.2 GUIDEFORM SPECIFICATIONS 1.2.1 DESCRIPTION

The Remote RTD module shall be capable of monitoring up to 12 three wire shielded RTDs. Each RTD input is to be indi-
vidually field programmable to type (that is, 100P, 100N, 120N, or 10C). The Remote RTD shall be capable of being daisy-
chained with 4 other RRTD modules to provide monitoring and protection of up to 60 RTDs.

The communication interface includes 3 independent RS485 ports and a fiber optic port. Modbus RTU is to be the standard
protocol.

The module shall be accompanied by supporting PC software, thus allowing easy programming and monitoring. The mod-
ule shall be capable of automatically communicating the RTD information to the 369 Motor Management Relay.

1.2.2 PROTECTION FEATURES

1.2.3 METERED QUANTITIES

1.2.4 ADDITIONAL FEATURES

ANSI/IEEE 
DEVICE

PROTECTION FEATURES TRIP ALARM

38 Bearing RTD 4 4

49 Stator RTD 4 4

Ambient RTD 4 4

Short/Low Temperature RTD 4

Broken/Open RTD 4

Loss of RRTD Communications 4

Self-Test/Service 4

METERED QUANTITY UNITS OPTION

Input Switch Status Open / Closed IO

Relay Output Status (De) Energized IO

RTD Temperature °C or °F

FEATURE OPTION

Modbus RTU Communications Protocol

User Definable Baud Rate (1200 to 19200)

Flash Memory for easy firmware updates

Rear RS485 communication port

Rear fiber optic port F

RTD type is user definable 

4 User Definable Analog Outputs (0 to 1 mA, 0 to 20 mA, 4 to 20 mA) IO

Windows based PC software for setup and monitoring
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1.3 TECHNICAL SPECIFICATIONSSpecifications are subject to change without notice.

1.3.1 INPUTS

CONTROL POWER
LO range: DC: 20 to 60 V DC

AC: 20 to 48 V AC at 50/60 Hz

HI range: DC: 50 to 300 V DC
AC: 40 to 265 V AC at 50/60 Hz

Power: nominal: 20 VA; maximum: 65 VA

Holdup: non-failsafe trip: 200 ms; failsafe trip: 100 ms

FUSE
T 3.15 A H 250 V (5 × 20 mm); Timelag high breaking capacity

DIGITAL / SWITCH INPUTS (IO option)
Inputs: 6 optically isolated

Input type: Dry Contact (< 800 Ω)

Function: Programmable

RTD INPUTS
Wire Type: 3 wire

Sensor Type: 100 Ω platinum (DIN 43760), 100 Ω nickel, 
120 Ω nickel, 10 Ω copper

RTD sensing current: 3 mA

Range: –40 to 200°C or –40 to 392°F

Accuracy: ±2°C or ±4°F

Lead Resistance: 25 Ω max. for Pt and Ni type;
3 Ω max. for Cu type

Isolation: 36 Vpk

1.3.2 OUTPUTS

ANALOG OUTPUTS (IO option)

Accuracy: ±1% of full scale

Isolation: 50 V isolated active source

OUTPUT RELAYS (IO option)

1.3.3 COMMUNICATIONS

BACK PORTS (3)
Type: RS485

Baud Rate: 1200 to 19200 baud

Protocol: Modbus® RTU

Isolation: 36 V (together)

FIBER OPTIC PORT (F option)
Optional Use: RTD remote module hookup 

Baud Rate: 1200 to 19200 baud

Protocol: Modbus® RTU

Fiber Sizes: 50/125, 62.5/125, 100/140, and 200 µm

1.3.4 PROTECTION ELEMENTS

38/49 RTD and RRTD PROTECTION
Pickup Level: 1 to 200°C or 34 to 392°F

Pickup Accuracy: ±2°C or ±4°F

Dropout Level: 96 to 98% of pickup above 80°C

Time Delay: <5 s

OPEN RTD ALARM
Pickup Level: detection of an open RTD

Pickup Accuracy: >1000 Ω
Dropout Level: 96 to 98% of pickup

Time Delay: <5 s

SHORT/LOW TEMP RTD ALARM
Pickup Level: <–40°C or –40°F

Pickup Accuracy: ±2°C or ±4°F

Dropout Level: 96 to 98% of pickup

Time Delay: <5 s

LOSS OF RRTD COMMS ALARM
Pickup Level: no communication

Time Delay: 2 to 5 s

PROGRAMMABLE

OUTPUT 0 to 1 mA 0 to 20 mA 4 to 20 mA

MAX LOAD 2400 Ω 600 Ω 600 Ω
MAX OUTPUT 1.01 mA 20.2 mA 20.2 mA

RESISTIVE LOAD 
(pf = 1)

INDUCTIVE LOAD 
(pf = 0.4)(L/R - 7ms)

RATED LOAD 8 A at 250 V AC
8 A at 30 V DC

3.5 A at 250 V AC
3.5 A at 30 V DC

CARRY CURRENT 8A

MAX SWITCHING 
CAPACITY

2000 VA
240 W

875 VA
170 W

MAX SWITCHING V 380 V AC 125 V DC

MAX SWITCHING I 8 A 3.5 A

OPERATE TIME <10 ms (5 ms typical)

CONTACT MATERIAL silver alloy
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GENERAL SWITCH
Time Delay: 0.1 to 5000.0 s in steps of 0.1

Start Delay: 0 to 5000 s in steps of 1

Timing Accuracy: ±200 ms or ±0.5% of total trip time,
whichever is greater

DIGITAL COUNTER
Pickup: on count equaling level

Time Delay: <200 ms

TRIP COUNTER
Pickup: on counting equalling level

Time Delay: <200 ms

1.3.5 ENVIRONMENTAL

AMBIENT TEMPERATURE
Operating Range: –40°C to +60°C
Storage Range: –40°C to +80°C

HUMIDITY
Up to 95% non condensing

DUST/MOISTURE
IP50

VENTILATION
No special ventilation required as long as ambient temperature 
remains within specifications. Ventilation may be required in enclo-
sures exposed to direct sunlight.

OVERVOLTAGE CATEGORY II

CLEANING
May be cleaned with a damp cloth.

The 369 must be powered up at least once per year to prevent deterioration of electrolytic capacitors.

1.3.6 APPROVALS / CERTIFICATION

ISO: Designed and manufactured to an ISO9001 
registered process.

CSA: CSA approved

UL: UL recognized

CE: Conforms to EN55011/CISPR 11,
EN50082-2, IEC947-1, 1010-1

1.3.7 TYPE TESTING

SURGE WITHSTAND CAPABILITY
ANSI/IEEE C37.90.1 Oscillatory (2.5 kV/1 MHz)

ANSI/IEEE C37.90.1 Fast Rise   (5 kV/10 ns)

IEC EN61000-4-4, Level 4

INSULATION RESISTANCE
IEC255-5

IMPULSE TEST
Per IEC 255-5 Section 8

DIELECTRIC STRENGTH
ANSI/IEEE C37.90; IEC 255-6; CSA C22.2

ELECTROSTATIC DISCHARGE
EN61000-4-2, Level 3; IEC 801-2

SURGE IMMUNITY
EN61000-4-5

CURRENT WITHSTAND
ANSI/IEEE C37.90; IEC 255-6

RFI
ANSI/IEEE C37.90.2, 35 V/m; EN61000-4-3; EN50082-2 at 10 V

CONDUCTED/RADIATED EMISSIONS
EN 55011 (CISPR 11)

TEMPERATURE/HUMIDITY WITH ACCURACY
ANSI/IEEE C37.90; IEC 255-6; IEC 68-2-38 Part 2

VIBRATION
IEC 255-21-1 Class 1; IEC 255-21-2 Class 1

VOLTAGE DEVIATION
EN61000-4-11

MAGNETIC FIELD IMMUNITY
EN61000-4-8

1.3.8 PRODUCTION TESTING

DIELECTRIC STRENGTH
All high voltage inputs at 2 kV AC for 1 minute

BURN IN
8 hours at 60°C sampling plan

CALIBRATION AND FUNCTIONALITY
100% hardware functionality tested

100% calibration of all metered quantities

NOTE

w . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
1-6 RRTD Remote RTD Module GE Multilin

w



2 INSTALLATION 2.1 MECHANICAL INSTALLATION

2

w

m
2 INSTALLATION 2.1 MECHANICAL INSTALLATION 2.1.1 DESCRIPTION

The RRTD is contained in a compact plastic housing with the keypad, display, communication port and all indicators/targets
on the front panel. The physical dimensions and mounting (drill diagram) are shown below. Mounting hardware consisting
of bolts and washers are provided with the module.

Although it is internally shielded to minimize noise pickup and interference, the RRTD should be mounted away from high
current conductors or sources of strong magnetic fields.

Figure 2–1: PHYSICAL DIMENSIONS
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2.2 TERMINAL IDENTIFICATION 2.2.1 TERMINAL LIST

Table 2–1: TERMINAL LIST

TERMINAL WIRING CONNECTION TERMINAL WIRING CONNECTION

1 RTD1 + 47 RTD12 COMPENSATION

2 RTD1 – 48 RTD12 SHIELD

3 RTD1 COMPENSATION 51 DIGITAL INPUT 6

4 RTD1 SHIELD 52 DIGITAL INPUT 6 COMMON

5 RTD2 + 53 DIGITAL INPUT 5

6 RTD2 – 54 DIGITAL INPUT 5 COMMON

7 RTD2 COMPENSATION 55 DIGITAL INPUT 4

8 RTD2 SHIELD 56 DIGITAL INPUT 4 COMMON

9 RTD3 + 57 DIGITAL INPUT 3

10 RTD3 – 58 DIGITAL INPUT 3 COMMON

11 RTD3 COMPENSATION 59 DIGITAL INPUT 2

12 RTD3 SHIELD 60 DIGITAL INPUT 2 COMMON

13 RTD4 + 61 DIGITAL INPUT 1

14 RTD4 – 62 DIGITAL INPUT 1 COMMON

15 RTD4 COMPENSATION 71 COMM1 RS485 +

16 RTD4 SHIELD 72 COMM1 RS485 –

17 RTD5 + 73 COMM1 SHIELD

18 RTD5 – 74 COMM2 RS485 +

19 RTD5 COMPENSATION 75 COMM2 RS485 –

20 RTD5 SHIELD 76 COMM2 SHIELD

21 RTD6 + 77 COMM3 RS485 +

22 RTD6 – 78 COMM3 RS485 –

23 RTD6 COMPENSATION 79 COMM3 SHIELD

24 RTD6 SHIELD 80 ANALOG OUT 1

25 RTD7 + 81 ANALOG OUT 2

26 RTD7 – 82 ANALOG OUT 3

27 RTD7 COMPENSATION 83 ANALOG OUT 4

28 RTD7 SHIELD 84 ANALOG COM

29 RTD8 + 85 ANALOG SHIELD

30 RTD8 – 111 TRIP NC

31 RTD8 COMPENSATION 112 TRIP COMMON

32 RTD8 SHIELD 113 TRIP NO

33 RTD9 + 114 ALARM NC

34 RTD9 – 115 ALARM COMMON

35 RTD9 COMPENSATION 116 ALARM NO

36 RTD9 SHIELD 117 AUX1 NC

37 RTD10 + 118 AUX1 COMMON

38 RTD10 – 119 AUX1 NO

39 RTD10 COMPENSATION 120 AUX2 NC

40 RTD10 SHIELD 121 AUX2 COMMON

41 RTD11 + 122 AUX2 NO

42 RTD11 – 123 POWER FILTER GROUND

43 RTD11 COMPENSATION 124 POWER LINE

44 RTD11 SHIELD 125 POWER NEUTRAL

45 RTD12 + 126 POWER SAFETY

46 RTD12 –w . 
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2.3 ELECTRICAL INSTALLATION 2.3.1 TYPICAL WIRING

Since the RRTD can cover a broad range of applications, wiring will be dependent upon the user’s protection and monitor-
ing scheme. This section covers most of the typical RRTD interconnections.

The terminals have been logically grouped together for explanation purposes. A typical wiring diagram for the RRTD is
shown below. For further information on specific wiring applications, please refer to Chapter 7: APPLICATIONS or contact
GE Multilin for further information.

Hazard may result if the product is not used for intended purposes. This equipment can only be serviced by trained
personnel.

Figure 2–2: TYPICAL WIRING
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2.3.2 CONTROL POWER

VERIFY THAT THE CONTROL POWER SUPPLIED TO THE RELAY IS WITHIN THE RANGE COVERED BY
THE ORDERED RRTD RELAY’S CONTROL POWER.

The RRTD power supply is a switchmode supply. It can operate with either AC or DC voltage applied to it.

Extensive filtering and transient protection has been incorporated into the RRTD to ensure reliable operation in harsh
industrial environments. Transient energy is removed from the module and conducted to ground via the ground terminal.
This terminal must be connected to the cubicle ground bus using a 10AWG wire or a ground braid. Do not daisy chain
grounds with other devices. Each should have its own connection to the ground bus.

The internal supply is protected via a 3.15 A slo-blo fuse that is accessible for replacement. If it must be replaced ensure
that it is replaced with a fuse of equal size (see Fuse Specifications in Technical Specifications - section 2)

2.3.3 RTD INPUTS

The RRTD can monitor up to 12 RTD inputs for Stator, Bearing, Ambient, or Other temperature applications. The type of
each RTD is field programmable as: 100 Ω Platinum (DIN.43760), 100 Ω Nickel, 120 Ω Nickel, or 10 Ω Copper. RTDs must
be the three wire type. There are no provisions for the connection of thermistors.

The RTD circuitry compensates for lead resistance, provided that each of the three leads is the same length. Lead resis-
tance should not exceed 25 Ω per lead for platinum and nickel type RTDs or 3 Ω per lead for Copper type RTDs.

Shielded cable should be used to prevent noise pickup in industrial environments. RTD cables should be kept close to
grounded metal casings and avoid areas of high electromagnetic or radio interference. RTD leads should not be run adja-
cent to or in the same conduit as high current carrying wires.

The shield connection terminal of the RTD is grounded in the RRTD and should not be connected to ground at the motor or
anywhere else to prevent noise pickup from circulating currents.

If 10 Ω Copper RTDs are used, special care should be taken to keep the lead resistance as low as possible to maintain
accurate readings.

Figure 2–3: RTD INPUTS

Table 2–2: RRTD POWER SUPPLY RANGES

RRTD POWER SUPPLY AC RANGE DC RANGE

HI 40 to 265 V 50 to 300 V

LO 20 to 48 V 20 to 60 V

CAUTION
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2.3.4 DIGITAL INPUTS

DO NOT CONNECT LIVE CIRCUITS TO THE RRTD DIGITAL INPUTS. THEY ARE DESIGNED FOR DRY CON-
TACT CONNECTIONS ONLY.

The RRTD provides 6 programmable digital inputs with the Input/Output option (IO). They can also be programmed for use
as generic inputs to set up trips and alarms or for monitoring purposes based on external contact inputs. 

A twisted pair of wires should be used for digital input connections.

2.3.5 ANALOG OUTPUTS

The RRTD provides 4 analog current output channels with the Input/Output option (IO). These outputs are field program-
mable to a full-scale range of either 0 to 1 mA (into a maximum 2.4 kΩ impedance) and 4 to 20 or 0 to 20 mA (into a maxi-
mum 600 Ω impedance).

As shown in Figure 2–2: TYPICAL WIRING on page 2–3, these outputs share one common return. Polarity of these outputs
must be observed for proper operation. 

Shielded cable should be used for connections, with only one end of the shield grounded, to minimize noise effects. The
analog output circuitry is isolated. Transorbs limit this isolation to ±36 V with respect to the RRTD safety ground.

If an analog voltage output is required, a burden resistor must be connected across the input of the SCADA or measuring
device (see the figure below). Ignoring the input impedance of the input,

For 0 to 1 mA, for example, if 5 V full scale is required to correspond to 1 mA,

For 4 to 20 mA, this resistor would be

Figure 2–4: ANALOG OUTPUT VOLTAGE CONNECTION

2.3.6 DISPLAY

Monitoring and setting of the RRTD module can be performed via the 369 Motor Management Relay through a communica-
tion link to the RRTD. If a stand alone RRTD is required, a Quick Panel display can be configured to monitor actual values.
The RTDPC program is used to program the module when it is configured as a stand alone.
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2.3.7 OUTPUT RELAYS

The RRTD provides four form C output relays. They have been labeled Trip, Aux 1, Aux 2 and Alarm. Each relay has nor-
mally open (NO) and normally closed (NC) contacts and can switch up to 8 A at either 250 V AC or 30 V DC with a resistive
load. The NO or NC state is determined by the ‘no power’ state of the relay outputs.

All four output relays may be programmed for fail-safe or non-fail-safe operation. When in fail-safe mode, output relay acti-
vation or a loss of control power will cause the contacts to go to their power down state.

For example:

• A fail-safe NO contact will close when the RRTD is powered up (if no prior unreset trip conditions) and will open when
activated (tripped) or when the RRTD loses control power.

• A non-fail-safe NO contact will remain open when the RRTD is powered up (unless a prior unreset trip condition) and
will close only when activated (tripped). If control power is lost while the output relay is activated (NO contacts closed)
the NO contacts will open.

Thus, in order to cause a trip on loss of control power to the RRTD, the Trip relay should be programmed as fail-safe. See
Figure 2–2: TYPICAL WIRING for typical wiring of contactors and breakers for fail-safe and non-fail-safe operation.

Output relays will remain latched after activation if the fault condition persists or the protection element has been pro-
grammed as latched. This means that once this relay has been activated it will remain in the active state until the RRTD is
manually reset. The Trip relay cannot be reset if a timed lockout is in effect. Lockout time will be adhered to regardless of
whether control power is present or not.

The relay contacts may be reset if motor conditions allow, by pressing the RESET key, using the REMOTE RESET switch
or via communications. The Emergency Restart feature overrides all features to reset the RRTD.

The rear of the RRTD relay shows output relay contacts in their power down state.

2.3.8 RS485 COMMUNICATIONS

Three independent two-wire RS485 ports are provided. If option (F), the fiber optic port, is installed and used the Comm 3
RS485 port, may not be used. The RS485 ports are isolated as a group.

Up to 32 devices can be daisy-chained together on a single serial communication channel without exceeding the driver
capability. For larger systems, additional serial channels must be added. Commercially available repeaters may also be
used to increase the number of relays on a single channel to a maximum of 254. Note that there may only be one master
device per serial communication link.

Connections should be made using shielded twisted pair cables (typically 24AWG). Suitable cables should have a charac-
teristic impedance of 120 Ω (e.g. Belden #9841) and total wire length should not exceed 4000 feet. Commercially available
repeaters can be used to extend transmission distances.

Voltage differences between remote ends of the communication link are not uncommon. For this reason, surge protection
devices are internally installed across all RS485 terminals. Internally, an isolated power supply with an optocoupled data
interface is used to prevent noise coupling. The source computer/PLC/SCADA system should have similar transient protec-
tion devices installed, either internally or externally, to ensure maximum reliability.

To ensure that all devices in a daisy-chain are at the same potential, it is imperative that the common termi-
nals of each RS485 port are tied together and grounded in one location only, at the master. Failure to do so
may result in intermittent or failed communications.

Correct polarity is also essential. RRTDs must be wired with all positive (+) terminals connected together and all negative
(–) terminals connected together. Each relay must be daisy-chained to the next one. Avoid star or stub connected configu-
rations. The last device at each end of the daisy chain should be terminated with a 120 Ω 1/4 W resistor in series with a 1nF
capacitor across the ‘+’ and ‘–’ terminals. Observing these guidelines will result in a reliable communication system that is
immune to system transients.

NOTE

CAUTION
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3 RTDPC INTERFACE 3.1 INTRODUCTION 3.1.1 REQUIREMENTS

The following minimum requirements must be met for the RTDPC software to operate properly.

Processor: Minimum 486, Pentium or higher recommended.

Memory: Minimum 4 MB RAM, 16 MB recommended. Minimum 540 K of conventional memory.

Hard Drive: 20 MB free space required before installation of software.

O/S: Minimum Windows 3.1/3.11, Windows NT, or Windows 95/98 (recommended).
Windows 3.1 Users must ensure that SHARE.EXE is installed.

Other: CD-ROM or internet capability to install RTDPC
(if neither is available, 3.5" floppy disks can be ordered from the factory)

If RTDPC is currently installed, note the path and directory name. This information is required when upgrading.

The RTDPC software is included on the GE Multilin Products CD included with the RRTD. If your PC does not have CD-
ROM capability, the software may be downloaded from the GE Multilin website at www.GEindustrial.com/multilin or ordered
on 3.5" floppy disks from the nearest GE Multilin office.

All products include the GE Multilin Products CD. Since this CD is essentially a “snapshot” of the GE Multilin web-
site, the procedures for installation from the CD and the Web are identical. However, the website will always contain
the newest versions and is recommended for upgrading the software.

3.1.2 INSTALLING RTDPC

Installation of the RTDPC software is accomplished as follows.

1. Ensure that Windows is running and functional on the local PC

2. Insert the GE Multilin Products CD into your CD-ROM drive or point your web browser to the GE Multilin website at
www.GEindustrial.com/multilin. With Windows 95/98, the Products CD will launch the welcome screen automatically
(alternately, you may open the index.htm file in the Products CD root directory). Since the Products CD is essentially
a “snapshot” of the GE Multilin website, the procedures for installation from the CD and the Web are identical from this
point forward.

3. Click the Index By Product Name item from the main page menu and select the RRTD Remote RTD Module from the
product list to open the RRTD product page.

4. Click the Software menu item from the Product Resources list to proceed to the RRTD software page.

5. The latest version of the RTDPC software will be shown. Select the RTDPC Program item to download the installation
program to your local PC. Run the installation program and follow the prompts to install the software to the desired
directory. When complete, a new GE Multilin group window will appear containing the RTDPC icon.

3.1.3 UPGRADING RTDPC

The following procedure determines if the currently installed version of RTDPC requires upgrading:

1. Run the RTDPC software.

2. Select the Help > About RTDPC menu item.

3. Compare the version shown in this window with the version on the Products CD or website. If the installed version is
lower than the version on the CD or web, then RTDPC needs to be upgraded.

4. To upgrade the RTDPC software, follow the installation instructions shown in the previous section. The installation pro-
gram will automatically upgrade the RTDPC software.

NOTE
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3.2 USING RTDPC 3.2.1 CONFIGURATION

1. Connect the computer containing the RTDPC software to the relay via the Channel 1 or 2 RS485 port. Channel 3 is
designated for communication to the 369 relay for remote RTD monitoring and is not meant for use with the RTDPC
software.

2. Run the RTDPC software. Once the program starts to operate, it will not automatically communicate with the relay
unless enabled to do so (see the Startup Mode option below). The LED status and display message shown will match
actual relay state if communications is established.

3. To setup communications, select Communication > Computer menu item.

Figure 3–1: COMMUNICATION / COMPUTER WINDOW

4. Set Slave Address  to match that programmed into relay.

5. Set Communication Port#  to the computer port connected to the relay.

6. Set Baud Rate and Parity  to match that programmed into relay.

7. Set Control Type  to type used.

8. Set Startup Mode  to the desired startup (communicate or file)

9. Select ON to enable communications with new settings.

3.2.2 UPGRADING FIRMWARE

1. To upgrade the relay firmware, connect a computer to the Channel 1 RS485 Port of the RRTD. Channels 2 and 3 can-
not be used to upgrade the relay firmware.

2. Run RTDPC and establish communications with the relay.

3. Select the Communication > Upgrade Firmware  menu item. The following window will appear:

4. Select Yes to proceed or No to abort. Remember, all previously programmed setpoints will be erased! If you have not
already created a setpoint file, it is highly recommended that the current setpoints be saved to disk by following the
procedure in Section 3.2.3: CREATING A NEW SETPOINT FILE on page 3–3 before continuing with the firmware
upgrade.

5. The Load Firmware window will appear. Locate the firmware file to load into the relay and select OK to proceed or
Cancel to quit the firmware upgrade.w . 
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6. The Upload Firmware dialog box shown below will appear. This provides one last chance to cancel the firmware
upgrade. Select Yes to proceed, No to load a different firmware file, or Cancel to end the firmware upgrade. This will
be the last chance to cancel the firmware upgrade – all previously programmed setpoints will be erased!

7. The RTDPC software automatically puts the relay into upload mode and then begin loading the file selected.

8. When loading is complete, the relay will require programming. To reload the previously programmed setpoints, see the
procedure in Section 3.2.5: DOWNLOADING A SETPOINT FILE on page 3–4.

3.2.3 CREATING A NEW SETPOINT FILE

1. To create a new setpoint file, run RTDPC. It is not necessary to have an RRTD unit connected to the computer to cre-
ate the file; however, some setpoint sections are only active if there is communication with an RRTD. The RTDPC sta-
tus bar will indicate that the program is in “Editing File” mode and “Not Communicating”.

2. From the Setpoint menu, choose the appropriate setpoints section to program, for example, S3 RTD Temperature >
RTD Protection to enter output relay setup setpoints.

Figure 3–2: RTD PROTECTION WINDOW

3. When you are finished programming a page, select OK to store the information to the RTDPC scratchpad memory
(note: this action does not store the information as a file on a disk).

4. Repeat steps 2 to 3 until all the desired setpoints are programmed.

5. Select the File > Save As  menu item to store these setpoints to the disk. Enter the location and file name of the set-
point file with a file extension of ‘.RTD’ and select OK.

6. The file is now saved. See Section 3.2.5: DOWNLOADING A SETPOINT FILE on page 3–4 for instructions on reload-
ing this file to the RRTD.
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3.2.4 EDITING A SETPOINT FILE

The following procedure describes how to edit setpoint files.

1. Run the RTDPC software. It is not necessary to have an RRTD unit connected to the computer. The status bar will indi-
cate that the program is in “Polling Relay” mode and “Not Communicating”.

2. If the RTDPC is communicating, select the Communication > Computer menu item to launch the COMMUNICA-
TION/COMPUTER window (see Figure 3–1: COMMUNICATION / COMPUTER WINDOW on page 3–2) and set Com-
municate to "Off". Click OK to turn off communications to the relay and place RTDPC in “Editing File” mode.

3. Open a setpoint file by selecting the File > Open menu item. Locate the appropriate RRTD setpoint files (ending with
the extension ’.RTD’) and select OK.

4. From the Setpoints menu item, choose the appropriate setpoints section to program; for example, System Setup >
Output Relay Setup to edit the output relay setup setpoints. When you have finished editing a page, select OK to
store the information to the RRTD scratchpad memory (NOTE: this action does not store the information as a file on a
disk).

5. Repeat Step 4 until all the desired setpoints are edited. Select the File > Save As menu item to store this file to disk.
Enter the location and file name of the setpoint file with a file extension of ‘.RTD’.

6. The file is now saved to disk. See Section 3.2.5: DOWNLOADING A SETPOINT FILE on page 3–4 for instructions on
downloading this file to the RRTD.

3.2.5 DOWNLOADING A SETPOINT FILE

The following procedure describes how to download setpoint files to the RRTD.

1. To download a pre-programmed setpoint file to the RRTD, run RTDPC and establish communications with the con-
nected relay via the RS485 connector.

2. Select the File > Open menu item to locate the setpoint file to be loaded into the relay. Click OK to load.

3. When the file is completely loaded, the RTDPC software will break communications with the connected relay and the
status bar changes to indicate “Editing File”, “Not Communicating”.

4. Select the File > Send Info To Relay menu item to download the setpoint file to the connected relay.

5. When the file is completely downloaded, the status bar will revert back to “Communicating”. The RRTD now contains
all the setpoints as programmed in the setpoint file.

If an attempt is made to download a setpoint file with a revision number that does not match the relay firmware revi-
sion, the following message type will appear:

See Section 3.2.6: UPGRADING SETPOINT FILE TO NEW REVISION on page 3–5 for instructions on upgrading
the setpoint file.

NOTE
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3.2.6 UPGRADING SETPOINT FILE TO NEW REVISION

The following procedure describes how to upgrade setpoint file revisions. It may be necessary to upgrade the revision code
for a previously saved setpoint file when the RRTD firmware is upgraded. 

1. To upgrade the revision of a previously saved setpoint file, run the 369PC software and establish communications with
the RRTD through the RS485 connector.

2. Select the Actual > A5 Relay Information menu item and record the Main Software revision number (for example,
59CMB115.000, where 115 is the main revision identifier and refers to firmware version 1.15).

Figure 3–3: RELAY INFORMATION WINDOW

3. Select the File > Open menu item and select the setpoint file to be downloaded to the connected relay. When the file is
open, the RTDPC software will be in “File Editing” mode and “Not Communicating”.

4. Select the File > Properties menu item and note the version code of the setpoint file.

Figure 3–4: SETPOINT FILE PROPERTIES

5. If the Version  code (e.g. 1.4X above) differs the firmware revision (noted in step 2 as 115), select the revision code that
matches the firmware from the pull-down tab. For example: for firmware revision 59CMB140.000 and current setpoint
revision as 1.15; change the Version  code to 1.4X to upgrade.

6. Select the File > Save  menu item to save the setpoint file.

7. To download the upgraded setpoint file to the RRTD, see Section 3.2.5: DOWNLOADING A SETPOINT FILE on page
3–4.
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3.2.7 PRINTING

This procedure describes how to print a list of the RRTD setpoints and/or actual values.

1. Start RTDPC. It is not necessary to establish communications.

2. Select the File > Open menu item to open a previously saved setpoint file, or
establish communications with a connected RRTD unit.

3. Select the File > Print Setup menu item. The following window will appear.

• Select Actual Values to print a list of actual values.

• Select Setpoints (All) or Setpoints (Enabled Features) to print a list of setpoints.

• Select User Definable Memory Map to print the user-definable memory map.

4. Click OK to close the Window.

5. Select the File > Print menu item to send the setpoint/actual values file to the connected printer.

3.2.8 TROUBLESHOOTING

This section provides some tips for troubleshooting RTDPC when troubles are encountered within the Windows environ-
ment, e.g. General Protection Fault (GPF), Missing Window, Problems in Opening/Saving Files, and Application
Error.

If the RRTD program causes Windows system errors:

• Ensure the RTDPC software is correctly installed and the PC being used meets the minimum requirements.

• Ensure that only one copy of RTDPC is running at a given time: the RTDPC software cannot multi-task.
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4 SETPOINTS 4.1 S1 SETUP 4.1.1 SETPOINT ACCESS

The communication access may be changed through the RTDPC software. Setpoint access is changed in the Setpoint >
S1 Setup menu item. An access tab is shown only when communicating with a relay. To set a passcode, click the Change
Passcode button. Enter and verify a new passcode; after a passcode is entered, the Setpoint Access changes to "Read
Only". When setpoints are changed through the PC program during Read Only access, the user is prompted to enter the
passcode before the new setpoint is stored. To allow extended write access, click on Allow Write Access and enter the
passcode. To change the access level back to "Read Only", click Restrict Write Access. If 30 minutes elapses without set-
point changes, or if control power is cycled, access automatically reverts to "Read Only".

If the access level is "Read and Write", write access to setpoints is automatic and a 0 passcode need not be entered. If the
programmed passcode is not known, consult the factory service department with the Encrypted Passcode to be decoded.

4.1.2 PREFERENCES

The Preferences section of the Setpoint > S1 Setup menu item allows the user to set the temperature display units to
either Celsius or Fahrenheit. The value chosen here will be reflected in all temperature actual values. RTD setpoints are
programmed in Celsius only.
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4.1.3 RRTD COMMUNICATIONS

The RRTD is equipped with three independent RS485 serial ports. The RRTD can act as a stand-alone unit or can be con-
nected along with a maximum of three (3) other RRTDs to the 369 Motor Management Relay. In this case, Channel 3
must be used for communication between the devices (see Section 6.1.4: MONITORING OF UP TO 60 RTDs on
page 6–3 for additional details).  Communications Channels 1 and 2 may be used by other devices (for example, comput-
ers or PLCs). Only Channel 1 may be used to upgrade firmware on the RRTD .

The CHANNEL 3 APPLICATION setpoint of the 369 must be set to "RRTD" and each Remote RTD must have its application
set to "Modbus" and assigned a unique address. Each RRTD slave address must be set prior to connecting it to the
network . Establish communication with only one RRTD by using the default slave address of 254. Then change the Slave
Address in the S1 Setpoints > Setup  window. When this new Slave Address is stored, the RRTD will lose communications
with RTDPC. At this point, the new address must then be stored in Communications Setup and communications re-estab-
lished with the relay.

Option F, a fiber optic port, may be ordered and used for Channel 3 communications. If the Channel 3 fiber optic port is
used, the Channel 3 RS485 connection is disabled.

RS485 communications support a subset of RTU protocol. Each must have a unique address from 1 to 254. Address 0 is
the broadcast address which all relays listen to. Addresses do not have to be sequential but no two devices can have the
same address or conflicts resulting in errors will occur. Generally each added to the link will use the next higher address
starting at 1. A maximum of 32 devices can be daisy chained and connected to a DCS, PLC or PC using the RS485 ports.
A repeater may be used to increase the number of relays on a single link to greater than 32.

4.1.4 REAL TIME CLOCK

The time/date stamp is used to track events for diagnostic purposes. The date and time are preset but may be entered
manually. A battery allows the internal clock to run continuously even when power is off. It has the same accuracy as an
electronic watch, approximately ±1 minute per month. It may be periodically corrected via the clock update command over
the serial link using the PC program.

Enter the current date using two digits for the month, two digits for the day, and four digits for the year. For example, July
15, 2001 would be entered as "07 15 2001". If entered from the keypad, the new date will take effect the moment the [Store
Relay Time and Date] button is clicked. Enter the current time, by using two digits for the hour in 24 hour time, two digits for
the minutes, and two digits for the seconds. If entered from the keypad, the new time will take effect the moment the [Store
Relay Time and Date] button is clicked.

If the serial communication link is used, then all the relays can keep time in synchronization with each other. A new clock
time is pre-loaded into the memory map via the communications port by a remote computer to each relay connected on the
communications channel. The computer broadcasts (address 0) a “set clock” command to all relays. Then all relays in the
system begin timing at the exact same instant. There can be up to 100 ms of delay in receiving serial commands so the
clock time in each relay is ±100 ms, ± the absolute clock accuracy in the PLC or PC (see Chapter 8: COMMUNICATIONS
for information on programming the time and synchronizing commands).w . 
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4.1.5 CLEAR/PRESET DATA

These commands may be used to clear various historical data. This is useful on new installations or to preset information
on existing installations where new equipment has been installed. The PRESET DIGITAL COUNTER message will only be
seen if one of the digital inputs has been configured as a digital input counter.

4.1.6 OPTIONS

The currently installed RRTD options, order code, and serial number are displayed in this window. If new options are
installed after ordering, select the relevant option ("Input/Output" and/or "Fiber Optic"), enter the passcode, and click the
Update Options Now button to update the RTDPC software to recognize them.
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4.2 S2 SYSTEM SETUP 4.2.1 DESCRIPTION

These setpoints are critical to the operation of the RRTD protective elements and control features. The output relay setup
and Control Functions are not shown if the IO option is not installed.

4.2.2 MONITORING SETUP

When the Trip Counter is enabled and the alarm pickup level is reached, an alarm will occur. To reset the alarm, the trip
counter must be cleared (see Section 4.1.5: CLEAR/PRESET DATA on page 4–3) or the pickup level increased and a reset
command issued. The trip counter alarm can be used to monitor and alarm when a predefined number of trips occur. This
would then prompt the operator or supervisor to investigate the causes of the trips that have occurred. See Section 5.3.1:
TRIP COUNTERS on page 5–4 for details of the individual trip counters.

4.2.3 OUTPUT RELAY SETUP

A latched relay (caused by a protective elements alarm or trip) may be reset at any time, providing that the condition that
caused operation is no longer present. Unlatched elements automatically reset when the condition has cleared.

These setpoints allow the relay output operation to be fail-safe or non-failsafe. The latchcode however, is defined individu-
ally for each protective element. Failsafe operation causes the output relay to energize in its normal state and de-energize
when activated by a protection element. A failsafe relay also changes state (if not already activated by a protection ele-
ment) when control power is removed from the RRTD. Conversely a non-failsafe relay de-energizes in its normal non-acti-
vated state and does not change state when control power is removed (if not already activated by a protection element).

The choice of failsafe or non-failsafe operation is usually determined by the application. In situations where the process is
more critical than the protected equipment, non-failsafe operation is typically programmed. In situations where the equip-
ment is more critical than the process, failsafe operation is programmed.
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4.2.4 CONTROL FUNCTIONS

If enabled the motor may be remotely started and stopped via Modbus communications to the RRTD. Refer to Section
8.2.8: FUNCTION CODE 16: PERFORMING COMMANDS on page 8–7 for details on how to send commands. When a
Stop command is sent the Trip relay will activate for 1 second to complete the trip coil circuit for a breaker application or
break the coil circuit for a contactor application. When a Start command is issued the relay assigned for starting control will
activate for 1 second to complete the close coil circuit for a breaker application or complete the coil circuit for a contactor
application.

The Serial Communication Control functions may also be used to reset the unit. Refer to 8.2.3: FUNCTION CODE 05:
EXECUTE OPERATION on page 8–4 for more information.
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4.3 S3 RTD TEMPERATURE 4.3.1 DESCRIPTION

These setpoints deal with the RTD overtemperature elements of the RRTD.

4.3.2 LOCAL RTD PROTECTION

• Application: Each individual RTD may be assigned an application. A setting of None effectively turns that individual
RTD off. Only RTDs with the application set to Stator are used for RTD biasing of the thermal model. 

• Type: Each RTD is individually assigned the RTD type connected to it. Multiple types may be used with a single RRTD.

• Name: Each RTD may be assigned an 8 character (maximum) name. This name is used in alarm and trip messages.

• Alarm/Hi Alarm/Trip: Each RTD can be programmed for separate Alarm, Hi Alarm and Trip levels and relays. Trips
are automatically stored as events. Alarms and Hi Alarms are stored as events only if the Record Alarms as Events
setpoint for that RTD is set to Yes.

• Trip Voting: This feature has been included for added RTD trip reliability in situations where RTD malfunction and nui-
sance tripping is common. If enabled that RTD will only trip if the RTD or RTDs listed to be voted with are also above
their trip level. For example, if RTD 1 is set to vote with All Stator RTDs, the RRTD will only trip if RTD 1 is above its trip
level and any one of the other stator RTDs is also above its own trip level. RTD voting is typically only used on Stator
RTDs and typically done between adjacent RTDs to detect hot spots.
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4.3.3 OPEN RTD ALARM

The RRTD has an Open RTD Sensor Alarm. This alarm will look at all RTDs that have been assigned an application other
than ‘None’ and determine if an RTD connection has been broken. When a broken sensor is detected, the assigned output
relay will operate and the RTDPC program will identify the RTD that is broken. It is recommended that if this feature is used,
the alarm be programmed as latched so that intermittent RTDs are detected and corrective action may be taken.

Table 4–1: RTD RESISTANCE TO TEMPERATURE

TEMPERATURE RTD RESISTANCE (IN OHMS)

°C °F 100 Ω Pt
(DIN43760)

120 Ω Ni 100 Ω Ni 10 Ω Cu

–40 –40 84.27 92.76 79.13 7.49

–30 –22 88.22 99.41 84.15 7.88

–20 –4 92.16 106.15 89.23 8.26

–10 14 96.09 113.00 94.58 8.65

0 32 100.00 120.00 100.0 9.04

10 50 103.90 127.17 105.6 9.42

20 68 107.79 134.52 111.2 9.81

30 86 111.67 142.06 117.1 10.19

40 104 115.54 149.79 123.0 10.58

50 122 119.39 157.74 129.1 10.97

60 140 123.24 165.90 135.3 11.35

70 158 127.07 174.25 141.7 11.74

80 176 130.89 182.84 148.3 12.12

90 194 134.70 191.64 154.9 12.51

100 212 138.50 200.64 161.8 12.90

110 230 142.29 209.85 168.8 13.28

120 248 146.06 219.29 176.0 13.67

130 266 149.82 228.96 183.3 14.06

140 284 153.58 238.85 190.9 14.44

150 302 157.32 248.95 198.7 14.83

160 320 161.04 259.30 206.6 15.22

170 338 164.76 269.91 214.8 15.61

180 356 168.47 280.77 223.2 16.00

190 374 172.46 291.96 231.6 16.39

200 392 175.84 303.46 240.0 16.78
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4.3.4 SHORT/LOW TEMP RTD ALARM

The RRTD has an RTD Short/Low Temperature alarm. This alarm will look at all RTDs that have an application other than
‘None’ and determine if an RTD has either a short or a very low temperature (less than –40°C). When a short/low tempera-
ture is detected, the assigned output relay will operate and a message will appear on the display identifying the RTD that
caused the alarm. It is recommended that if this feature is used, the alarm be programmed as latched so that intermittent
RTDs are detected and corrective action may be taken.
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4.4 S4 DIGITAL INPUTS 4.4.1 DIGITAL INPUT FUNCTIONS

Any of the programmable digital inputs may be programmed as a General Switch Input or Digital Counter.

Digital input alarms and trips (both General or Digital Counter) are activated at the local module, the mas-
ter’s output relays DO NOT activate.

Only one digital input may be selected as a digital counter at a time. User defined units and counter name may be defined
and these will appear on all counter related actual value and alarm messages. To clear a digital counter alarm, the alarm
level must be increased or the counter must be cleared or preset to a lower value.

NOTE
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4.5 S5 ANALOG OUTPUTS 4.5.1 ANALOG OUTPUT PARAMETER SELECTION

The analog outputs are only configurable for the local RTDs.

Table 4–2: ANALOG OUTPUT PARAMETERS

PARAMETER NAME RANGE /UNITS STEP DEFAULT

MINIMUM MAXIMUM

Hottest Stator RTD –40 to +200°C or –40 to +392°F 1 0 200

RTD #1 to 12 –40 to +200°C or –40 to +392°F 1 –40 200

NOTE
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4.6 S6 TESTING 4.6.1 FORCE OUTPUT RELAYS

The Force Output Relay feature provides a method of performing checks on all relay contact outputs. The feature can also
be used for control purposes while the equipment is operating. The forced state overrides the normal operation of the relay
output.

The forced state, if enabled (energized or de-energized), will force the selected relay into the programmed state for as long
as the programmed duration. After the programmed duration expires the forced state will return to disabled and relay oper-
ation will return to normal. If the duration is programmed as Static, the forced state will remain in effect until changed or dis-
abled. If control power to the RRTD is interrupted, any forced relay condition will be removed.

4.6.2 FORCE ANALOG OUTPUTS

The Force Analog Output setpoints may be used during startup or testing to verify that the analog outputs are functioning
correctly. It may also be used when the motor is running to give manual or communication control of an analog output.
Forcing an analog output overrides its normal functionality.

When the Force Analog Outputs Function is enabled, the output will reflect the forced value as a percentage of the range 4
to 20 mA, 0 to 20 mA, or 0 to 1 mA. Selecting Off will place the analog output channels back in service, reflecting the
parameters programmed to each.
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5 ACTUAL VALUES 5.1 A1 STATUS 5.1.1 LAST TRIP DATA

Immediately prior to a trip, the RRTD records the cause of trip, the date and time and stores this as pre-trip value. This
allows for ease of troubleshooting when a trip occurs. These values are overwritten when the next trip occurs. 

The resetting of any latched trip or alarm is done here. All RTD trips and alarms are activated at the master only; thus any
latched RTD trip or alarm is resettable at the master by clicking on the Reset button. On the other hand, digital trips or
alarms are activated at the slave only; thus any latched digital trip or alarm is resettable by clicking on the related RRTD
reset button.

5.1.2 ALARM STATUS

Any active alarm may be viewed here. If the Line Up and Down keys are not pressed, the active messages will automati-
cally cycle. The current level causing the alarm is displayed along with the alarm name.
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5.1.3 DIGITAL INPUT STATUS

The present state of the digital inputs will be displayed here.

5.1.4 OUTPUT RELAY STATUS

The present state of the output relays will be displayed here. Energized indicates that the NO contacts are now closed and
the NC contacts are now open. De-energized indicates that the NO contacts are now open and the NC contacts are now
closed. Forced indicates that the output relay has been commanded into a certain state.

5.1.5 REAL TIME CLOCK

The date and time from the RRTD real time clock may be viewed here.
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5.2 A2 TEMPERATURE DATA 5.2.1 LOCAL RTD

• LOCAL RTD: The temperature level of all 12 internal RTDs will be displayed here. The programmed name of each
RTD (if changed from the default) will appear as the first line of each message.

5.2.2 LOCAL RTD MAXIMUMS

• LOCAL RTD MAXIMUMS: The maximum temperature level of all 12 internal RTDs will be displayed. The programmed
name of each RTD (if changed from the default) will appear as the first line of each message.
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5.3 A3 STATISTICAL DATA 5.3.1 TRIP COUNTERS

A breakdown of the number of trips by type is displayed here. When the total reaches 50000, the counter resets to 0 on the
next trip and continues counting. This information can be cleared in the Setpoints > S1 Setup menu item (see Clear/Pre-
set tab). The date the counters are cleared is recorded.

5.3.2 STATISTICS

The digital counter is displayed when one of the digital inputs is set as a digital counter. The digital counter can be cleared
in the Setpoints > S1 Setup menu item (see Clear/Presets tab). When the digital counter reaches 65535, it is automati-
cally reset to 0.
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5.4 A4 EVENT RECORDER 5.4.1 EVENT RECORDER

The event recorder stores system information each time an event occurs (for example, a motor trip). A maximum of 40
events are stored, with Event 1 representing the oldest event. When the number of events exceeds 40, Event 1 is deleted
from the event recorder.

Details of selected events can be viewed by clicking the View Data button. Select events by clicking the checkboxes in the
Select column. This data can be stored and/or printed for future reference.
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5.5 RELAY INFORMATION AND COMMMANDS 5.5.1 A5 RELAY INFORMATION

RRTD model and manufacture information may be viewed here. The last calibration date is the date the relay was last cali-
brated at GE Multilin. This information reflects the revisions of the software currently running in the RRTD. This information
should be noted and recorded before calling for technical support or service.

5.5.2 COMMANDS

RRTD commands are performed through the Commands menu, allowing for the refreshing and resetting of local RRTDs.

a) RESET RRTD

Each individual RRTD can be reset through the commands menu. This is used to reset RRTD units that have the IO option
and have a latched trip or alarm active.

b) REFRESH RRTD

The refresh command sends the setpoints that are saved in the master RRTD to the slave. This command is used when
replacing a RRTD unit.
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6 APPLICATIONS 6.1 RTD CIRCUITRY 6.1.1 RTD CIRCUIT OPERATION

The following is an explanation of how the RTD circuitry works in the RRTD.

Figure 6–1: RTD CIRCUITRY

A constant current source sends 3 mA DC down legs A and C. A 6 mA DC current returns down leg B. It may be seen that:

or

The above holds true providing that all three leads are the same length, gauge, and material, hence the same resistance.

or

Electronically, subtracting VAB from VBC leaves only the voltage across the RTD. In this manner lead length is effectively
negated:

6.1.2 TWO WIRE RTD LEAD COMPENSATION

An example of how to add lead compensation to a two wire RTD is shown below.

Figure 6–2: 2 WIRE RTD LEAD COMPENSATION

The compensation lead would be added and it would compensate for the Hot and the Return assuming they are all of equal
length and gauge. To compensate for resistance of the Hot and Compensation leads, a resistor equal to the resistance of
the Hot lead could be added to the compensation lead, though in many cases this is unnecessary.
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6.1.3 REDUCED RTD LEAD NUMBER APPLICATION

The RRTD requires three leads to be brought back from each RTD: Hot, Return, and Compensation. In certain situations
this can be quite expensive. However, it is possible to reduce the number of leads so that three are required for the first
RTD and only one for each successive RTD. Refer to the following diagram for wiring configuration.

Figure 6–3: REDUCED WIRING RTDs

The Hot line is run as usual for each RTD. However, the Compensation and Return leads need only be run for the first RTD.
At the motor RTD terminal box, connect the RTD Return leads together with as short as possible jumpers. At the RRTD
unit, the Compensation leads must be jumpered together.

Note that an error is produced on each RTD equal to the voltage drop across the RTD return jumper. This error increases
for each successive RTD added as:

VRTD1 = VRTD1

VRTD2 = VRTD2 + VJ3

VRTD3 = VRTD3 + VJ3 + VJ4

VRTD4 = VRTD4 + VJ3+ VJ4 + VJ5, etc....

This error is directly dependent on the length and gauge of the jumper wires and any error introduced by a poor connection.
For RTD types other than 10C, the error introduced by the jumpers is negligible.

Although this RTD wiring technique reduces the cost of wiring, the following disadvantages must be noted:

1. There is an error in temperature readings due to lead and connection resistances. Not  recommended for 10C RTDs.

2. If the RTD Return lead to the RRTD or one of the jumpers breaks, all RTDs from the point of the break onwards will
read open.

3. If the Compensation lead breaks or one of the jumpers breaks, all RTDs from the point of the break onwards will func-
tion without any lead compensation.
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RETURN
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MOTOR
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6.1.4 MONITORING OF UP TO 60 RTDs

A maximum of four (4) RRTD modules with a 369 can be daisy-chained together as illustrated in Figure 6–5: DAISY
CHAINING RRTD MODULES on page 6–4. This provides the capability of monitoring up to 60 RTDs.

The 369 Motor Management Relay is designated as the master and the other RRTDs as the slaves. Each of the RRTD
slave modules must be programmed with a unique SLAVE ADDRESS before they can be daisy-chained together. Program-
ming is accomplished via RTDPC by connecting to either the Channel 1 or Channel 1 RS485 port. When all devices con-
nected to the 369 are communicating properly, the 369PC software can also be used to program individual RRTD modules.

Figure 6–4: RTDPC SCREEN

Since the RRTD does not have a display, a HMI, such as the Quick Panel Jr., can be connected to one of the communica-
tion ports. The HMI can be configured to display the information of choice. Visit the GE Multilin Web site to obtain a Quick
Panel configuration template.
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Figure 6–5: DAISY CHAINING RRTD MODULES
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6.2 USING THE RRTD WITH THE 469 RELAY 6.2.1 INTRODUCTION

Using the RRTD with the 469 eliminates the necessity of wiring RTDs back to the 469 for monitoring and/or control func-
tions.

Any RRTDs used with the 469 MUST have the IO option.

The following three scenarios are addressed in this section: control via the 469, monitoring via the 469, and monitoring and
control via the 469. Although only three specific scenarios are described, it is possible to use combinations of them. It is up
to the customer’s discretion to apply them according to their needs.

6.2.2 CONTROL VIA THE 469

Use this setup if the application requires the 469 to control RTD trips and no monitoring by the 469 is required.

1. Wire the RTDs to the RRTD and program the RRTD with trip and alarm levels as described in the RRTD instruction
manual. Program all RRTD trips and alarms as unlatched.

2. Wire trip and alarm output relays from the RRTD to the 469 digital input(s). Program the 469 digital input(s) (one or
more of the General Switch A-D) and assign the appropriate output relay. The General Switch inputs can be renamed
to indicate that it is an RRTD trip or alarm (i.e. RRTD Trip).

3. A trip or alarm from the RRTD will now cause the 469 to issue the trip or alarm to the control scheme. The output relay
of the RRTD will reset as soon as the condition is cleared. The 469 output relay will reset according to whether it is pro-
grammed as latched or unlatched.

4. If monitoring of the RTD temperatures is required, the data can be read from the RRTD through communications.

6.2.3 MONITORING VIA THE 469

Use this setup if the application requires the RRTD to control tripping and/or alarms and it is desirable to have the 469 mon-
itor RTD temperatures.

1. Wire the RTDs to the RRTD as described in the RRTD instruction manual. If tripping and/or alarms are required, pro-
gram the RRTD accordingly and wire the RRTD output relays into the control scheme.

2. The RRTD has 4 Analog Outputs that can be wired to the 469 Analog Inputs. They can be programmed to represent
individual RTDs or the Hottest Stator RTD.

3. Program the 469 Analog Input Name with the appropriate RTD name (e.g. "Remote RTD1"). Rename the 469 Analog
Input Units (e.g. Deg C). Program the input range and minimum/maximum levels to match the RRTD settings.

4. The RTD temperatures can now be monitored by the 469 Analog Input metering data.

5. The RTD temperatures can also be obtained from the 469 through communications (by reading the appropriate Analog
Input metering memory map addresses) or by programming the 469 analog outputs appropriately.

6.2.4 MONITORING AND CONTROL VIA THE 469

This setup is to be used if the application requires the 469 to both monitor RTD temperatures and control tripping and/or
alarming. This setup provides the most benefit from using the RRTD with the 469.

1. Wire RTDs to the RRTD as described in the RRTD instruction manual. DO NOT wire RRTD output relays into the con-
trol scheme and DO NOT program any trips or alarms in the RRTD.

2. Wire the required number of RRTD Analog Outputs to the 469 Analog Inputs. They can be programmed to represent
individual RTDs or the Hottest Stator RTD.

3. Program the 469 Analog Input Name with the appropriate RTD name (e.g. "Remote RTD1"). Rename the 469 Analog
Input Units (e.g. Deg C). Program the input range and minimum/maximum levels to match the RRTD settings.

4. Program the 469 Analog Inputs with the appropriate trip and/or alarm levels.

NOTE
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5. The RTD temperatures can now be monitored through the 469 Analog Input metering data. The temperatures can also
be obtained from the 469 through communications (by reading the appropriate Analog Input metering memory map
addresses) or by programming the 469 analog outputs appropriately.

6. The 469 will now control trips and/or alarms for remote RTDs. See the wiring diagram below for details.

Figure 6–6: RRTD/469 WIRING DIAGRAMw . 
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7 TESTING 7.1 TEST SETUP 7.1.1 INTRODUCTION

This chapter demonstrates the procedures necessary to perform a complete functional test of all the RRTD hardware while
also testing firmware/hardware interaction in the process. Testing of the relay during commissioning wiring is correct and
complete.

7.1.2 TEST SETUP

Figure 7–1: SECONDARY INJECTION TEST SETUP
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7.2 HARDWARE  FUNCTIONAL TESTING 7.2.1 RTD ACCURACY TEST

The RRTD specification for RTD input accuracy is ±2°C. Perform the steps below to verify accuracy.

1. Select an RTD type of 100 Platinum for all of the 12 RTDs.

2. Measured values should be ±2°C or ±4°F. Alter the resistances applied to the RTD inputs as per the table below to
simulate RTDs and verify accuracy of the measured values. View the measured values in:

A2 TEMPERATURE DATA \ LOCAL RTD

3. Select the preferred temperature units for the display. Alter the following setpoint:

S1 SETUP \  PREFERENCES \ TEMPERATURE DISPLAY: "Celsius" ( or "Fahrenheit" if preferred)

4. Repeat the above measurements for the other RTD types (120 Ω Nickel, 100 Ω Nickel and 10 Ω Copper).

APPLIED 
RESISTANCE 

100 Ω 
PLATINUM

EXPECTED RTD TEMPERATURE 
READING

MEASURED RTD TEMPERATURE
á SELECT ONE: ____(°C) ____(°F)

CELSIUS FAHRENHEIT 1 2 3 4 5 6 7 8 9 10 11 12

80.31 Ω –50°C –58°F

100.00 Ω 0°C 32°F

119.39 Ω 50°C 122°F

138.50 Ω 100°C 212°F

157.32 Ω 150°C 302°F

175.84 Ω 200°C 392°F

APPLIED 
RESISTANCE 
120 Ω NICKEL

EXPECTED RTD TEMPERATURE 
READING

MEASURED RTD TEMPERATURE
á SELECT ONE: ____(°C) ____(°F)

CELSIUS FAHRENHEIT 1 2 3 4 5 6 7 8 9 10 11 12

86.17 Ω –50°C –58°F

120.00 Ω 0°C 32°F

157.74 Ω 50°C 122°F

200.64 Ω 100°C 212°F

248.95 Ω 150°C 302°F

303.46 Ω 200°C 392°F

APPLIED 
RESISTANCE 
100 Ω NICKEL

EXPECTED RTD TEMPERATURE 
READING

MEASURED RTD TEMPERATURE
á SELECT ONE: ____(°C) ____(°F)

CELSIUS FAHRENHEIT 1 2 3 4 5 6 7 8 9 10 11 12

71.81 Ω –50°C –58°F

100.00 Ω 0°C 32°F

131.45 Ω 50°C 122°F

167.20 Ω 100°C 212°F

207.45 Ω 150°C 302°F

252.88 Ω 200°C 392°F

APPLIED 
RESISTANCE 
10 Ω COPPER

EXPECTED RTD TEMPERATURE 
READING

MEASURED RTD TEMPERATURE
á SELECT ONE: ____(°C) ____(°F)

CELSIUS FAHRENHEIT 1 2 3 4 5 6 7 8 9 10 11 12

7.10 Ω –50°C –58°F

9.04 Ω 0°C 32°F

10.97 Ω 50°C 122°F

12.90 Ω 100°C 212°F

14.83 Ω 150°C 302°F

16.78 Ω 200°C 392°F

18.73 Ω 250°C 482°Fw . 
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7.2.2 DIGITAL INPUTS

The digital inputs can be verified easily with a simple switch or pushbutton. Perform the steps below to verify functionality.

1. Open switches of all of the digital inputs.

2. View the status of the digital inputs and trip coil supervision in:

A1 STATUS \ DIGITAL INPUT STATUS

3. Close switches of all of the digital inputs. View the status of the digital inputs in:

A1 STATUS \ DIGITAL INPUT STATUS

7.2.3 ANALOG OUTPUTS

The RRTD specification for analog input and analog output accuracy is ±1% of full scale. Perform the steps below to verify
accuracy for each of the three analog inputs.

4 TO 20mA ANALOG INPUTS:

1. Alter the following setpoints:

S5 ANALOG OUTPUTS \ LOCAL ANALOG OUTPUTS \ ANALOG OUT 1 \ ANALOG RANGE: "4-20 mA"
(repeat for analog inputs 2 to 4)

2. Analog output values should be ±0.2 mA on the ammeter. Force the analog outputs using the following setpoints:

S6 TESTING \ TEST ANALOG OUTPUTS \ FORCE ANALOG OUTPUT 1: "0%"
(enter desired percent, repeat for analog outputs 2 to 4)

3. Verify the ammeter readings for all the analog outputs

4. Repeat steps 1 to 3 for the other forced output settings

0 TO 1 mA ANALOG INPUTS:

1. Alter the following setpoints:

S10 ANALOG OUTPUTS \ LOCAL ANALOG OUTPUTS \ ANALOG OUT 1 \ ANALOG RANGE: "0-1 mA"
(repeat for analog inputs 2 to 4)

2. Analog output values should be ±0.01 mA on the ammeter. Force the analog outputs using the following setpoints:

S6 TESTING \ TEST ANALOG OUTPUTS \ FORCE ANALOG OUTPUT 1: "0%"
(enter desired percent, repeat for analog outputs 2 to 4)

INPUT EXPECTED 
STATUS

(SWITCH OPEN)

á PASS
à FAIL

EXPECTED STATUS
(SWITCH CLOSED)

á PASS
à FAIL

DIGITAL INPUT 1 Open Shorted

DIGITAL INPUT 2 Open Shorted

DIGITAL INPUT 3 Open Shorted

DIGITAL INPUT 4 Open Shorted

DIGITAL INPUT 5 Open Shorted

DIGITAL INPUT 6 Open Shorted

ANALOG OUTPUT 
FORCE VALUE

EXPECTED AMMETER 
READING

MEASURED AMMETER READING (mA)

1 2 3 4

0 4 mA

25 8 mA

50 12 mA

75 16 mA

100 20 mA
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3. Verify the ammeter readings for all the analog outputs

4. Repeat 1 to 3 for the other forced output settings

0 TO 20 mA ANALOG INPUTS:

1. Alter the following setpoints:

S5 ANALOG OUTPUTS \ LOCAL ANALOG OUTPUTS \  ANALOG OUT 1 \ ANALOG RANGE: "0-20 mA"
(repeat for analog inputs 2 to 4)

2. Analog output values should be ±0.2mA on the ammeter. Force the analog outputs using the following setpoints:

S6 TESTING \ TEST ANALOG OUTPUTS \ FORCE ANALOG OUTPUT 1: "0%"
(enter desired percent, repeat for analog outputs 2 to 4)

3. Verify the ammeter readings for all the analog outputs

4. Repeat 1 to 3 for the other forced output settings

7.2.4 OUTPUT RELAYS

To verify the functionality of the output relays, perform the following steps:

1. Use the following setpoints:

S6 TESTING \ TEST OUTPUT RELAYS \ FORCE TRIP RELAY: "Energized"
S6 TESTING \ TEST OUTPUT RELAYS \ FORCE TRIP RELAY DURATION: "Static"

2. Using the above setpoints, individually select each of the other output relays ( AUX 1, AUX 2 and ALARM) and verify
operation.

ANALOG OUTPUT 
FORCE VALUE

EXPECTED AMMETER 
READING

MEASURED AMMETER READING (mA)

1 2 3 4

0 0 mA

25 0.25 mA

50 0.5 mA

75 0.75 mA

100 1.0 mA

ANALOG OUTPUT 
FORCE VALUE

EXPECTED AMMETER 
READING

MEASURED AMMETER READING (mA)

1 2 3 4

0 0 mA

25 5 mA

50 10 mA

75 15 mA

100 20 mA

FORCE 
OPERATION 
SETPOINT

EXPECTED MEASUREMENT (á for SHORT) ACTUAL MEASUREMENT (á for SHORT)

R1 R2 R3 R4 R1 R2 R3 R4

no nc no nc no nc no nc no nc no nc no nc no nc

R1 Trip á á á á

R2 Auxiliary á á á á

R3 Auxiliary á á á á

R4 Alarm á á á á

w . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
7-4 RRTD Remote RTD Module GE Multilin

w



8 COMMUNICATIONS 8.1 OVERVIEW

8

w

m
8 COMMUNICATIONS 8.1 OVERVIEW 8.1.1 ELECTRICAL INTERFACE

The electrical interface consists of one of three 2-wire RS485 ports from the rear terminal connector. In a 2-wire RS485 link,
data flow is bidirectional and half-duplex; that is, data is not transmitted and received at the same time. RS485 lines should
be connected in a daisy-chain configuration (avoid star connections) with a terminating network installed at each end of the
link; that is, at the master end and at the slave furthest from the master. The terminating network should be a 120 Ω resistor
in series with a 1 nF ceramic capacitor when used with Belden 9841 RS485 wire. The value of the terminating resistors
should be equal to the characteristic impedance of the line. This is approximately 120 Ω for standard #22 AWG twisted pair
wire. Shielded wire should always be used to minimize noise. Polarity is important in RS485 communications: the ’+’ termi-
nals of all devices must be connected together for the system to operate. See Section 2.3.8: RS485 COMMUNICATIONS
on page 2–6 for details on correct serial port wiring.

When using a fibre optic link the Tx from the RRTD should be connected to the Rx of the Master device and the Rx from the
RRTD should be connected to the Tx of the Master device. 

8.1.2 MODBUS COMMUNICATIONS

The RRTD implements a subset of the AEG Modicon Modbus RTU protocol. Many popular programmable controllers sup-
port this protocol directly with a suitable interface card allowing direct connection. Although the Modbus protocol is hard-
ware independent, the RRTD interfaces are three 2-wire RS485 ports. Modbus is a single master, multiple slave protocol
suitable for a multi-drop configuration as provided by RS485 hardware. In this configuration, up to 32 slaves can be daisy-
chained together on a single communication channel.

The RRTD is always a slave – it cannot be a master. Computers or PLCs are commonly programmed as masters. The
Modbus protocol exists in two versions: Remote Terminal Unit (RTU, binary) and ASCII. Only the RTU version is supported
by the RRTD. Monitoring, programming, and control functions are enacted using read/write register commands.

8.1.3 DATA FRAME FORMAT AND DATA RATE

One data frame of an asynchronous transmission to or from an RRTD is default to 1 start bit, 8 data bits, and 1 stop bit.
This produces a 10 bit data frame. This is important for transmission through modems at high bit rates (11 bit data frames
are not supported by Hayes modems at bit rates of greater than 300 bps). The parity bit is optional as odd or even. If it is
programmed as odd or even, the data frame consists of 1 start bit, 8 data bits, 1 parity bit, and 1 stop bit.

The Modbus protocol can be implemented at any standard communication speed. The RRTD RS485, fiber optic, and
RS232 ports support operation at 1200, 2400, 4800, 9600, and 19200 baud. 

8.1.4 DATA PACKET FORMAT

A complete request/response sequence consists of the following bytes (transmitted as separate data frames):

Master Request Transmission:
SLAVE ADDRESS - 1 byte
FUNCTION CODE - 1 byte
DATA - variable number of bytes depending on FUNCTION CODE
CRC - 2 bytes

Slave Response Transmission:
SLAVE ADDRESS - 1 byte
FUNCTION CODE - 1 byte
DATA - variable number of bytes depending on FUNCTION CODE
CRC - 2 bytes

SLAVE ADDRESS: The first byte of every transmission representing the user-assigned address of the slave device. Each
slave device must be assigned a unique address – only the addressed slave responds to a transmission that starts with its
address. In a master request, the SLAVE ADDRESS identifies slave receiving the request. In a slave response, the SLAVE
ADDRESS identifies the slave sending the response. A master transmission with a SLAVE ADDRESS of 0 indicates a
broadcast command. Broadcast commands can be used for specific functions.

FUNCTION CODE: The second byte of every transmission. The Modbus protocol defines function codes 1 to 127 (the
RRTD implements some of these functions). In a master request, the FUNCTION CODE tells the slave what action to per-w . 
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form. If the FUNCTION CODE in a slave response is the same as that sent from the master, then the function was per-
formed as requested. If the high order bit of the FUNCTION CODE sent from the slave is a 1 (i.e. FUNCTION CODE > 127)
then the slave did not perform the function as requested and is sending an error or exception response.

DATA: A variable number of bytes depending on the FUNCTION CODE. This may be actual values, setpoints, or
addresses sent by the master to the slave or by the slave to the master. Data is sent MSByte first followed by the LSByte.

CRC: This is a two byte error checking code. CRC is sent LSByte first followed by the MSByte.

8.1.5 ERROR CHECKING

The Modbus RTU includes a two byte CRC-16 (16 bit cyclic redundancy check) with every transmission. The CRC-16 algo-
rithm treats the entire data stream (data bits only; start, stop, and parity ignored) as one continuous binary number. This
number is shifted left 16 bits and then divided by a characteristic polynomial (11000000000000101B). The 16 bit remainder
is appended to the end of the transmission, LSByte first. The resulting message and CRC, when divided by the same poly-
nomial at the receiver, gives a zero remainder if no transmission errors have occurred.

An RRTD Modbus slave device will not respond to transmission with CRC-16 calculation errors. A CRC-16 error indicates
than one or more bytes were received incorrectly and should be ignored to avoid incorrect operation. The CRC-16 calcula-
tion is an industry standard method used for error detection. An algorithm is included here to assist programmers in situa-
tions where no standard CRC-16 calculation routines are available.

8.1.6 CRC-16 ALGORITHM

Once the following algorithm is complete, the working register "A" will contain the CRC value to be transmitted. Note that
this algorithm requires the characteristic polynomial to be reverse bit ordered. The MSbit of the characteristic polynomial is
dropped since it does not affect the value of the remainder. The following symbols are used in the algorithm:

--> data transfer
A 16 bit working register
AL low order byte of A
AH high order byte of A
CRC 16 bit CRC-16 value
i, j loop counters
(+) logical exclusive or operator
Di i-th data byte (i = 0 to N-1)
G 16 bit characteristic polynomial = 1010000000000001 with MSbit dropped and bit order reversed
shr(x) shift right (the LSbit of the low order byte of x shifts into a carry flag, a ’0’ is shifted into the

MSbit of the high order byte of x, all other bits shift right one location

The algorithm is as follows:

1. FFFF hex --> A

2. 0 --> i

3. 0 --> j

4. Di (+) AL --> AL

5. j+1 --> j

6. shr(A)

7. is there a carry? No: go to 8.; Yes: G (+) A --> A

8. is j = 8? No: go to 5.; Yes: go to 9.

9. i+1 --> i

10. is i = N? No: go to 3; Yes: go to 11.

11. A --> CRC

8.1.7 TIMING

Data packet synchronization is maintained by timing constraints. The receiving device measures the time between the
reception of characters. If 3.5 character times elapse without a new character or packet completion, then the communica-
tion link must be reset (i.e. all slaves start listening for a new transmission from the master). Thus, at 9600 baud a delay
greater than 3.5 × 1 / 9600 × 10 = 3.65 ms resets the communication link.
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8.2 SUPPORTED MODBUS FUNCTIONS 8.2.1 DESCRIPTION

The following functions are supported by the RRTD:

• 03: Read Setpoints and Actual Values

• 04: Read Setpoints and Actual Values

• 05: Execute Operation

• 06: Store Single Setpoint

• 07: Read Device Status

• 08: Loopback Test

• 16: Store Multiple Setpoints

8.2.2 FUNCTION CODES 03 & 04: READ SETPOINTS & ACTUAL VALUES

Modbus implementation: Read Input and Holding Registers
RRTD Implementation: Read Setpoints and Actual Values

For the RRTD implementation of Modbus, these commands can be used to read any Setpoint ("holding registers") or Actual
Value ("input registers"). Holding and input registers are 16 bit (two byte) values transmitted high order byte first. Thus all
RRTD Setpoints and Actual Values are sent as two bytes. The maximum number of registers that can be read in one trans-
mission is 125. Function codes 03 and 04 are configured to read setpoints or actual values interchangeably because some
PLCs do not support both function codes.

The slave response to these function codes is the slave address, function code, a count of the number of data bytes to fol-
low, the data itself and the CRC. Each data item is sent as a two byte number with the high order byte sent first. The CRC
is sent as a two byte number with the low order byte sent first.

MESSAGE FORMAT AND EXAMPLE:

Request slave 11 to respond with 2 registers starting at address 0308. For this example the register data in these
addresses is follows – address 0308: 0064; address 0309: 000A.

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 03 read registers

DATA STARTING ADDRESS 2 03 08 data starting at 0308

NUMBER OF SETPOINTS 2 00 02 2 registers (4 bytes total)

CRC 2 45 27 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 03 read registers

BYTE COUNT 1 04 2 registers = 4 bytes

DATA 1 2 00 64 value in address 0308

DATA 2 2 00 0A value in address 0309

CRC 2 EB 91 CRC calculated by the slave
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8.2.3 FUNCTION CODE 05: EXECUTE OPERATION

Modbus Implementation: Force Single Coil
RRTD Implementation: Execute Operation

This function code allows the master to request an RRTD to perform specific command operations. The command numbers
listed in the Commands area of the memory map correspond to operation code for function code 05. The operation com-
mands can also be initiated by writing to the Commands area of the memory map using function code 16. Refer to FUNC-
TION 16 - STORE MULTIPLE SETPOINTS for complete details.

SUPPORTED OPERATIONS:

• Reset RRTD (operation code 1)

• Start Device (operation code 2)
• Stop Device (operation code 3)

MESSAGE FORMAT AND EXAMPLE – RESET RRTD (OPERATION CODE 1):

8.2.4 FUNCTION CODE 06 - STORE SINGLE SETPOINT

Modbus Implementation: Preset Single Register
RRTD Implementation: Store Single Setpoint

This command allows the master to store a single setpoint into the memory of an RRTD. The slave response to this func-
tion code is to echo the entire master transmission.

MESSAGE FORMAT AND EXAMPLE:

Request slave 11 to store the value 01F4 in Setpoint address 1180. After the transmission in this example is complete, set-
point address 1180 will contain the value 01F4.

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 05 execute operation

OPERATION CODE 2 00 01 reset RRTD (operation code 1)

CODE VALUE 2 FF 00 perform function

CRC 2 DD 50 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 05 execute operation

OPERATION CODE 2 00 01 reset command (operation code 1)

CODE VALUE 2 FF 00 perform function

CRC 2 EB 91 CRC calculated by the slave

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 06 store single setpoint

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

DATA 2 01 F4 data address 1180

CRC 2 8D A3 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 06 store single setpoint

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

DATA 2 01 F4 data stored in address 1180

CRC 2 EB 91 CRC calculated by the slavew . 
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8.2.5 FUNCTION CODE 07: READ DEVICE STATUS

Modbus Implementation: Read Exception Status
RRTD Implementation: Read Device Status

This is a function used to quickly read the status of a selected device. A short message length allows for rapid reading of
status. The status byte returned will have individual bits set to 1 or 0 depending on the status of the slave device.

RRTD GENERAL STATUS BYTE:

LSBit B0: Trip relay energized = 1
B1: Aux 1 relay energized = 1
B2: Aux 2 relay energized = 1
B3: Alarm relay energized = 1
B4: Stopped = 1
B5: Starting = 1
B6: Running = 1

MSBit B7: Tripped =1

MESSAGE FORMAT AND EXAMPLE:

8.2.6 FUNCTION CODE 08: LOOPBACK TEST

Modbus Implementation: Loopback Test
RRTD Implementation: Loopback Test

This function is used to test the integrity of the communication link. The RRTD will echo the request.

MESSAGE FORMAT AND EXAMPLE:

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 07 read device status

CRC 2 47 42 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 07 read device status

DEVICE STATUS 1 59 status = 01011001 in binary

CRC 2 C2 08 CRC calculated by the slave

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 06 store single setpoint

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

DATA 2 01 F4 data address 1180

CRC 2 8D A3 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 06 store single setpoint

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

DATA 2 01 F4 data stored in address 1180

CRC 2 EB 91 CRC calculated by the slavew . 
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8.2.7 FUNCTION CODE 16: STORE MULTIPLE SETPOINTS

Modbus Implementation: Preset Multiple Registers
RRTD Implementation: Store Multiple Setpoints

This function code allows multiple setpoints to be stored into the RRTD memory. Modbus "registers" are 16 bit (two byte)
values transmitted high order byte first. Thus all RRTD setpoints are sent as two bytes. The maximum number of Setpoints
that can be stored in one transmission is dependent on the slave device. Modbus allows up to a maximum of 60 holding
registers to be stored. The RRTD response to this function code is to echo the slave address, function code, starting
address, the number of Setpoints stored, and the CRC.

MESSAGE FORMAT AND EXAMPLE:

Request slave 11 to store the value 01F4 to Setpoint address 1180 and the value 01DE to setpoint address 1181. After the
transmission in this example is complete, RRTD slave 11 will have the following setpoints information stored – address
1180: 01F4; address 1181: 01DE.

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 10 store setpoints

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

NUMBER OF SETPOINTS 2 00 02 2 setpoints (4 bytes total)

BYTE COUNT 1 04 4 bytes of data

DATA 1 2 01 F4 data for address 1180

DATA 2 2 01 DE data for address 1181

CRC 2 DB B1 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 10 store setpoints

DATA STARTING ADDRESS 2 11 80 setpoint address 1180

NUMBER OF SETPOINTS 2 00 02 2 setpoints

CRC 2 45 B6 CRC calculated by the slave
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8.2.8 FUNCTION CODE 16: PERFORMING COMMANDS

Some PLCs may not support execution of commands using function code 5 but do support storing multiple setpoints using
function code 16. To perform this operation using function code 16 (10H), a certain sequence of commands must be written
at the same time to the RRTD. The sequence consists of: Command Function register, Command operation register and
Command Data (if required). The Command Function register must be written with the value of 5 indicating an execute
operation is requested. The Command Operation register must then be written with a valid command operation number
from the list of commands shown in the memory map. The Command Data registers must be written with valid data if the
command operation requires data. The selected command will execute immediately upon receipt of a valid transmission.

MESSAGE FORMAT AND EXAMPLE:

Perform a reset on RRTD (operation code 1):

8.2.9 ERROR RESPONSES

When an RRTD detects an error other than a CRC error, a response will be sent to the master. The MSbit of the FUNC-
TION CODE byte will be set to 1 (i.e. the function code sent from the slave will be equal to the function code sent from the
master plus 128). The following byte will be an exception code indicating the type of error that occurred.

Transmissions received from the master with CRC errors will be ignored by the RRTD.

The slave response to an error (other than CRC error) will be:

• SLAVE ADDRESS: 1 byte

• FUNCTION CODE: 1 byte (with MSbit set to 1)

• EXCEPTION CODE: 1 byte

• CRC: 2 bytes

The RRTD implements the following exception response codes.

• 01: ILLEGAL FUNCTION

The function code transmitted is not one of the functions supported by the RRTD.

• 02: ILLEGAL DATA ADDRESS

The address referenced in the data field transmitted by the master is not an allowable address for the RRTD.

• 03: ILLEGAL DATA VALUE

The value referenced in the data field transmitted by the master is not within range for the selected data address.

MASTER TRANSMISSION: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B message for slave 11

FUNCTION CODE 1 10 store setpoints

DATA STARTING ADDRESS 2 00 80 setpoint address 0080

NUMBER OF SETPOINTS 2 00 02 2 setpoints (4 bytes total)

BYTE COUNT 1 04 4 bytes of data

COMMAND FUNCTION 2 00 05 data for address 0080

COMMAND OPERATION 2 00 01 data for address 0081

CRC 2 0B D6 CRC calculated by the master

SLAVE RESPONSE: BYTES EXAMPLE / DESCRIPTION

SLAVE ADDRESS 1 0B response message from slave 11

FUNCTION CODE 1 10 store setpoints

DATA STARTING ADDRESS 2 00 80 setpoint address 0080

NUMBER OF SETPOINTS 2 00 02 2 setpoints

CRC 2 40 8A CRC calculated by the slave

w . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
o

GE Multilin RRTD Remote RTD Module 8-7

w



8.3 MEMORY MAP 8 COMMUNICATIONS

8

w

om
8.3 MEMORY MAP 8.3.1 DESCRIPTION

The data stored in the RRTD is grouped as Setpoints and Actual Values. Setpoints can be read and written by a master
computer. Actual Values are read only. All Setpoints and Actual Values are stored as two byte values. That is, each register
address is the address of a two byte value. Addresses are listed in hexadecimal. Data values (Setpoint ranges, increments,
factory values) are in decimal.

Note: Many Modbus communications drivers add 40001d to the actual address of the register addresses. For example: if
address 0h was to be read, 40001d would be the address required by the Modbus communications driver; if address 320h
(800d) was to be read, 40801d would be the address required by the Modbus communications driver.

8.3.2 USER DEFINABLE MEMORY MAP AREA

The RRTD has a powerful feature, called the User Definable Memory Map, which allows a computer to read up to 124 non-
consecutive data registers (setpoints or actual values) by using one Modbus packet. It is often necessary for a master com-
puter to continuously poll various values in each of the connected slave relays. If these values are scattered throughout the
memory map, reading them would require numerous transmissions and would burden the communication link. The User
Definable Memory Map can be programmed to join any memory map address to one in the block of consecutive User Map
locations, so that they can be accessed by reading these consecutive locations.

The User Definable area has two sections:

1. A Register Index area (memory map addresses 0180h to 01FCh) that contains 125 actual values or setpoints register
addresses.

2. A Register area (memory map addresses 0100h to 017Ch) that contains data at the addresses in the register index.

Register data that is separated in the rest of the memory map may be remapped to adjacent register addresses in the User
Definable Registers area. This is accomplished by writing to register addresses in the User Definable Register Index area.
This allows for improved through-put of data and can eliminate the need for multiple read command sequences.

For example, if the values of Average Phase Current (register address 0306h) and Hottest Stator RTD Temperature (regis-
ter address 0320h) are required to be read from an RRTD, their addresses may be remapped as follows:

1. Write 0306h to address 0180h (User Definable Register Index 0000) using function code 06 or 16.

2. Write 0320h to address 0181h (User Definable Register Index 0001) using function code 06 or 16.

A read (function code 03 or 04) of registers 0100h (User Definable Register 0000) will return the Phase A Current and reg-
ister 0101h (User Definable Register 0001) will return Hottest Stator RTD Temperature.
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8.3.3 MEMORY MAP

Table 8–1: MEMORY MAP (Sheet 1 of 11)

ADDR 
(hex)

DESCRIPTION MIN. MAX. STEP 
VALUE

UNITS FORMAT 
CODE

FACTORY 
DEFAULT

PRODUCT ID (ADDRESSES 0000 TO 007F)
PRODUCT ID

0000 GE Multilin Product Code - - - - F1 53

0001 Product Hardware Revision 1 26 1 N/A F15 A

0002 Firmware Revision N/A N/A N/A N/A F16 N/A

0003 Modification Number 0 999 1 N/A F1 0

0004 Boot Revision 0 999 1 - F1 0

0005 Boot Mod Number - - - - - -

0006 Reserved - - - - - -

0007 Reserved - - - - - -

0008 Order Code 0 63 1 N/A 0

↓ ↓ - - - - - -

000F Modify Options 0 N/A - N/A N/A -

0010 Modify Options Passcode Characters 1 & 2 32 127 1 - F1 " "

↓ ↓ - - - - - -

0017 Modify Options Passcode Characters 15 & 16 32 127 1 - F1 " "

--- Reserved - - - - - -

0020 Serial Number character 1 and 2 N/A N/A N/A ASCII F22 N/A

0021 Serial Number character 3 and 4 N/A N/A N/A ASCII F22 N/A

0022 Serial Number character 5 and 6 N/A N/A N/A ASCII F22 N/A

0023 Serial Number character 7 and 8 N/A N/A N/A ASCII F22 N/A

0024 Serial Number character 9 and 10 N/A N/A N/A ASCII F22 N/A

0025 Serial Number character 11 and 12 N/A N/A N/A ASCII F22 N/A

... Reserved - - - - - -

0030 Calibration Date 1995 2094 1 - F18 Jan.1,1999

... Reserved - - - - - -

0040 Manufacturing Date 1995 2094 1 - F18 Jan.1,1999

... Reserved - - - - - -

SETPOINT ACCESS
0050 Keypad Access Level 0 1 1 N/A F162 0

0051 Comm Access Level 0 1 1 N/A F162 0

0052 Access Password Character 1 and 2 32 127 1 - F1 " "

0053 Access Password Character 3 and 4 32 127 1 - F1 " "

0054 Access Password Character 5 and 6 32 127 1 - F1 " "

0055 Access Password Character 7 and 8 32 127 1 - F1

0056 Encrypted Access Password 1 and 2 32 127 1 - F1 “AI”

0057 Encrypted Access Password 3 and 4 32 127 1 - F1 “KF”

0058 Encrypted Access Password 5 and 6 32 127 1 - F1 “BA”

0059 Encrypted Access Password 7 and 8 32 127 1 - F1 IK”

... Reserved - - - - - -

COMMANDS (ADDRESSES 0000 TO 00FF)
0080 Command Function Code 0 12 1 - F31 0

... Reserved

USER MAP (ADDRESSES 0100 TO 017F)
0100 User Map Value # 1 --- --- --- --- --- ---

↓ ↓
017C User Map Value # 125 --- --- --- --- --- ---

... Reserved

0180 User Map Address # 1 0 3FFF 1 hex F1 0

↓ ↓
01FC User Map Address # 125 0 3FFF 1 hex F1 0

... Reserved

ACTUAL VALUES (ADDRESSES 0220 TO 0FFF)
LAST TRIP DATA

0220 Cause of Last Trip 0 276 1 - F134 0

0221 Time of Last Trip (2 words) N/A N/A N/A N/A F19 -w . 
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0223 Date of Last Trip (2 words) N/A N/A N/A N/A F18 -

... Reserved - - - - - -

ALARM STATUS
0260 Digital Input 6 Alarm Status 0 4 1 - F123 0

0261 Digital Input 2 Alarm Status 0 4 1 - F123 0

0262 Digital Input 5 Alarm Status 0 4 1 - F123 0

0263 Digital Input 4 Alarm Status 0 4 1 - F123 0

0264 Digital Input 1 Alarm Status 0 4 1 - F123 0

0265 Digital Input 3 Alarm Status 0 4 1 - F123 0

... Reserved - - - - - -

027D Local RTD #1 Alarm Status 0 4 1 - F123 0

027E Local RTD #2 Alarm Status 0 4 1 - F123 0

027F Local RTD #3 Alarm Status 0 4 1 - F123 0

0280 Local RTD #4 Alarm Status 0 4 1 - F123 0

0281 Local RTD #5 Alarm Status 0 4 1 - F123 0

0282 Local RTD #6 Alarm Status 0 4 1 - F123 0

0283 Local RTD #7 Alarm Status 0 4 1 - F123 0

0284 Local RTD #8 Alarm Status 0 4 1 - F123 0

0285 Local RTD #9 Alarm Status 0 4 1 - F123 0

0286 Local RTD #10 Alarm Status 0 4 1 - F123 0

0287 Local RTD #11 Alarm Status 0 4 1 - F123 0

0288 Local RTD #12 Alarm Status 0 4 1 - F123 0

0289 Local RTD #1 High Alarm Status 0 4 1 - F123 0

028A Local RTD #2 High Alarm Status 0 4 1 - F123 0

028B Local RTD #3 High Alarm Status 0 4 1 - F123 0

028C Local RTD #4 High Alarm Status 0 4 1 - F123 0

028D Local RTD #5 High Alarm Status 0 4 1 - F123 0

028E Local RTD #6 High Alarm Status 0 4 1 - F123 0

028F Local RTD #7 High Alarm Status 0 4 1 - F123 0

0290 Local RTD #8 High Alarm Status 0 4 1 - F123 0

0291 Local RTD #9 High Alarm Status 0 4 1 - F123 0

0292 Local RTD #10 High Alarm Status 0 4 1 - F123 0

0293 Local RTD #11 High Alarm Status 0 4 1 - F123 0

0294 Local RTD #12 High Alarm Status 0 4 1 - F123 0

0295 Broken / Open RTD Alarm Status 0 4 1 - F123

0296 Short / Low Temp Alarm Status 0 1 1 - F123

0297 Lost Remote RTD Communication 0 4 1 - F123

0298 Trip Counter Alarm Status 0 4 1 - F123 0

... Reserved - - - - - -

029E Self Test Alarm

... Reserved - - - - - -

DIGITAL INPUT STATUS
02D0 Digital Input 3 0 1 1 - F131 0

02D1 Digital Input 4 0 1 1 - F131 0

02D2 Digital Input 6 0 1 1 - F131 0

02D3 Digital Input 5 0 1 1 - F131 0

02D4 Digital Input 2 0 1 1 - F131 0

02D5 Digital Input 1 0 1 1 - F131 0

... Reserved

OUTPUT RELAY STATUS
02E0 Trip 0 2 1 N/A F150 2

02E1 Alarm 0 2 1 N/A F150 2

02E2 Aux.1 0 2 1 N/A F150 2

02E3 Aux.2 0 2 1 N/A F150 2

... Reserved

REAL TIME CLOCK
02F0 Date (Read Only) N/A N/A N/A N/A F18 N/A

02F4 Time (Read Only) N/A N/A N/A N/A F19 N/A

... Reserved

Table 8–1: MEMORY MAP (Sheet 2 of 11)

ADDR 
(hex)

DESCRIPTION MIN. MAX. STEP 
VALUE

UNITS FORMAT 
CODE

FACTORY 
DEFAULT
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TEMPERATURE
031F Hottest Stator RTD Number 0 12 1 - F1 0

0320 Hottest Stator RTD Temperature -40 200 1 oC F4 40

0321 Local RTD #1 Temperature -40 200 1 oC F4 40

0322 Local RTD #2 Temperature -40 200 1 oC F4 40

0323 Local RTD #3 Temperature -40 200 1 oC F4 40

0324 Local RTD #4 Temperature -40 200 1 oC F4 40

0325 Local RTD #5 Temperature -40 200 1 oC F4 40

0326 Local RTD #6 Temperature -40 200 1 oC F4 40

0327 Local RTD #7 Temperature -40 200 1 oC F4 40

0328 Local RTD #8 Temperature -40 200 1 oC F4 40

0329 Local RTD #9 Temperature -40 200 1 oC F4 40

032A Local RTD #10 Temperature -40 200 1 oC F4 40

032B Local RTD #11 Temperature -40 200 1 oC F4 40

032C Local RTD #12 Temperature -40 200 1 oC F4 40

... Reserved

RTD MAXIMUMS
03E0 Local RTD # 1 Max. Temperature -40 200 1 oC F4 40

03E1 Local RTD # 2 Max. Temperature -40 200 1 oC F4 40

03E2 Local RTD # 3 Max. Temperature -40 200 1 oC F4 40

03E3 Local RTD # 4 Max. Temperature -40 200 1 oC F4 40

03E4 Local RTD # 5 Max. Temperature -40 200 1 oC F4 40

03E5 Local RTD # 6 Max. Temperature -40 200 1 oC F4 40

03E6 Local RTD # 7 Max. Temperature -40 200 1 oC F4 40

03E7 Local RTD # 8 Max. Temperature -40 200 1 oC F4 40

03E8 Local RTD # 9 Max. Temperature -40 200 1 oC F4 40

03E9 Local RTD # 10 Max. Temperature -40 200 1 oC F4 40

03EA Local RTD # 11 Max. Temperature -40 200 1 oC F4 40

03EB Local RTD # 12 Max. Temperature -40 200 1 oC F4 40

... Reserved

TRIP COUNTERS
0430 Total Number of Trips 0 50000 1 - F1 0

... Reserved

0433 Switch Trips 0 50000 1 - F1 0

... Reserved

044E Stator RTD Trips 0 50000 1 - F1 0

044F Bearing RTD Trips 0 50000 1 - F1 0

0450 Other RTD Trips 0 50000 1 - F1 0

0451 Ambient RTD Trips 0 50000 1 - F1 0

... Reserved

0457 Trip Counters Last Cleared N/A N/A N/A N/A F18 N/A

... Reserved

SETPOINTS (ADDRESSES 1000 TO 1FFF)
DISPLAY PREFERENCES

1000 Default Message Cycle Time 5 100 1 s F1 20

1001 Default Message Timeout 10 900 1 s F1 300

1002 Contrast Adjustment 1 254 1 - F1 145

1003 Flash Message 1 10 1 s F1 2

1004 Temperature Display Units 0 1 1 - F100 0

... Reserved

RRTD COMMUNICATIONS
1010 Slave Address 1 254 1 - F1 254

1011 Computer RS232 Baud Rate 0 4 1 - F101 4

1012 Computer RS232 Parity 0 2 1 - F102 0

1013 CHANNEL 1 Parity 0 2 1 - F102 4

1014 CHANNEL 1 Baud Rate 0 4 1 - F101 0

1015 CHANNEL 2 Parity 0 2 1 - F102 4

1016 CHANNEL 2 Baud Rate 0 4 1 - F101 0

1017 CHANNEL 3 Parity 0 2 1 - F102 4

Table 8–1: MEMORY MAP (Sheet 3 of 11)

ADDR 
(hex)

DESCRIPTION MIN. MAX. STEP 
VALUE

UNITS FORMAT 
CODE

FACTORY 
DEFAULT
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1018 CHANNEL 3 Baud Rate 0 4 1 - F101 0

1019 CHANNEL 3 Connection 0 1 1 - F151 0

101A CHANNEL 3 Application 0 1 1 - F149 0

... Reserved

REAL TIME CLOCK
1030 Date (2 words) valid date N/A - F18 -

1034 Time (2 words) valid time N/A - F19 -

... Reserved

MESSAGE SCRATCHPAD
1060 1st & 2nd Character of 1st Scratchpad Message 32 127 1 - F1 ’T’

↓ ↓
1073 39th & 40th Character of 1st Scratchpad Message 32 127 1 - F1 " "

1074 1st & 2nd Character of 2nd Scratchpad Message 32 127 1 - F1 ’T’

↓ ↓
1087 39th & 40th Character of 2nd Scratchpad Message 32 127 1 - F1 " "

1088 1st & 2nd Character of 3rd Scratchpad Message 32 127 1 - F1 ’T’

↓ ↓
109B 39th & 40th Character of 3rd Scratchpad Message 32 127 1 - F1 " "

109C 1st & 2nd Character of 4th Scratchpad Message 32 127 1 - F1 ’T’

↓ ↓
10AF 39th & 40th Character of 4th Scratchpad Message 32 127 1 - F1 " "

10B0 1st & 2nd Character of 5th Scratchpad Message 32 127 1 - F1 ’T’

↓ ↓
10C3 39th & 40th Character of 5th Scratchpad Message 32 127 1 - F1 " "

... Reserved

CLEAR PRESET DATA
1130 Clear Last Trip Data 0 1 1 - F103 0

1131 Reserved - - - - - -

1132 Clear RTD Maximums 0 1 1 - F103 0

1133 Reserved - - - - - -

1134 Clear Trip Counters 0 1 1 - F103 0

1135 Preset Digital Counter 0 65535 1 - F1 0

1136 Clear Event Records 0 1 1 - F103 0

... Reserved

1143 RRTD 1 - Preset Digital Counter 0 65535 1 - F1 0

1145 RRTD 2 - Preset Digital Counter 0 65535 1 - F1 0

1147 RRTD 3 - Preset Digital Counter 0 65535 1 - F1 0

1149 RRTD 4 - Preset Digital Counter 0 65535 1 - F1 0

... Reserved

DIGITAL COUNTER
12E6 First Character of Counter Name 32 127 1 - F1 “G”

12F2 First Character of Counter Unit Name 32 127 1 - F1 ‘U’

12F8 Counter Type 0 1 1 - F114 0

12F9 Digital Counter Alarm 0 2 1 - F115 0

12FA Assign Alarm Relays 0 6 1 - F113 0

12FB Counter Alarm Level 0 65535 1 - F1 100

12FD Reserved - - - - - -

12FE Record Alarms as Events 0 1 1 - F103 0

DIGITAL INPUT 2
1330 1st & 2nd Character of Digital Input 2 Name 32 127 1 - F22 ’G’

1340 General Digital Input 2 Type 0 1 1 - F116 0

1341 General Digital Input 2 Block Input From Start 0 5000 1 s F1 0

1342 General Digital Input 2 Alarm 0 2 1 - F115 0

1343 General Digital Input 2 Alarm Relays 0 6 1 - F113 0

1344 General Digital Input 2 Alarm Delay 1 50000 1 100ms F2 50

1345 General Digital Input 2 Alarm Events 0 1 1 - F103 0

1346 General Digital Input 2 Trip 0 2 1 - F115 0

1347 General Digital Input 2 Trip Relays 0 6 1 - F111 0

1348 General Digital Input 2 Trip Delay 1 50000 1 100ms F2 50

Table 8–1: MEMORY MAP (Sheet 4 of 11)

ADDR 
(hex)

DESCRIPTION MIN. MAX. STEP 
VALUE

UNITS FORMAT 
CODE

FACTORY 
DEFAULT

w . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
8-12 RRTD Remote RTD Module GE Multilin

w



8 COMMUNICATIONS 8.3 MEMORY MAP

8

w

m

1349 Digital Input 2 Assignable Function 0 7 1 - F163 0

... Reserved

DIGITAL INPUT 5
1370 1st & 2nd Character of Digital Input 5 Name 32 127 1 - F22 ’G’

1380 General Digital Input 5 Type 0 1 1 - F116 0

1381 General Digital Input 5 Block Input From Start 0 5000 1 s F1 0

1382 General Digital Input 5 Alarm 0 2 1 - F115 0

1383 General Digital Input 5 Alarm Relays 0 7 1 - F113 1

1384 General Digital Input 5 Alarm Delay 1 50000 1 100ms F2 50

1385 General Digital Input 5 Alarm Events 0 1 1 - F103 0

1386 General Digital Input 5 Trip 0 2 1 - F115 0

1387 General Digital Input 5 Trip Relays 0 7 1 - F111 1

1388 General Digital Input 5 Trip Delay 1 50000 1 100ms F2 50

1389 Digital Input 5 Assignable Function 0 7 1 - F163 0

... Reserved

DIGITAL INPUT 4
13A0 1st & 2nd Character of Digital Input 4 Name 32 127 1 - F22 ’G’

13B0 General Digital Input 4 Type 0 1 1 - F116 0

13B1 General Digital Input 4 Block Input from Start 0 5000 1 s F1 0

13B2 General Digital Input 4 Alarm 0 2 1 - F115 0

13B3 General Digital Input 4 Alarm Relays 0 7 1 - F113 1

13B4 General Digital Input 4 Alarm Delay 1 50000 1 100ms F2 50

13B5 General Digital Input 4 Alarm Events 0 1 1 - F103 0

13B6 General Digital Input 4 Trip 0 2 1 - F115 0

13B7 General Digital Input 4 Trip Relays 0 7 1 - F111 1

13B8 General Digital Input 4 Trip Delay 1 50000 1 100ms F2 50

13B9 Digital Input 4 Assignable Function 0 7 1 - F163 0

... Reserved

DIGITAL INPUT 1
13D0 1st & 2nd Character of Digital Input 1 Name 32 127 1 - F22 ’G’

13E0 General Digital Input 1 Type 0 1 1 - F116 0

13E1 General Digital Input 1 Block Input From Start 0 5000 1 s F1 0

13E2 General Digital Input 1 Alarm 0 2 1 - F115 0

13E3 General Digital Input 1 Alarm Relays 0 7 1 - F113 1

13E4 General Digital Input 1 Alarm Delay 1 50000 1 100ms F2 50

13E5 General Digital Input 1 Alarm Events 0 1 1 - F103 0

13E6 General Digital Input 1 Trip 0 2 1 - F115 0

13E7 General Digital Input 1 Trip Relays 0 7 1 - F111 1

13E8 General Digital Input 1 Trip Delay 1 50000 1 100ms F2 50

13E9 Digital Input 1 Assignable Function 0 7 1 - F163 0

... Reserved

DIGITAL INPUT 6
1400 1st & 2nd Character of Digital Input 6 Name 32 127 1 - F22 ’G’

1410 General Digital Input 6 Type 0 1 1 - F116 0

1411 General Digital Input 6 Block Input From Start 0 5000 1 s F1 0

1412 General Digital Input 6 Alarm 0 2 1 - F115 0

1413 General Digital Input 6 Alarm Relays 0 7 1 - F113 1

1414 General Digital Input 6 Alarm Delay 1 50000 1 100ms F2 50

1415 General Digital Input 6 Alarm Events 0 1 1 - F103 0

1416 General Digital Input 6 Trip 0 1 1 - F115 0

1417 General Digital Input 6 Trip Relays 0 7 1 - F111 1

1418 General Digital Input 6 Trip Delay 1 50000 1 100 ms F2 50

1419 Digital Input 6 Assignable Function 0 7 1 - F163 0

... Reserved

DIGITAL INPUT 3
1420 1st & 2nd Character of Digital Input 3 Name 32 127 1 - F22 ’G’

1430 General Digital Input 3 Type 0 1 1 - F116 0

1431 General Digital Input 3 Block Input From Start 0 5000 1 s F1 0

1432 General Digital Input 3 Alarm 0 2 1 - F115 0

Table 8–1: MEMORY MAP (Sheet 5 of 11)
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1433 General Digital Input 3 Alarm Relays 0 7 1 - F113 1

1434 General Digital Input 3 Alarm Delay 1 50000 1 100ms F2 50

1435 General Digital Input 3 Alarm Events 0 1 1 - F103 0

1436 General Digital Input 3 Trip 0 1 1 - F115 0

1437 General Digital Input 3 Trip Relays 0 7 1 - F111 1

1438 General Digital Input 3 Trip Delay 1 50000 1 100 ms F2 50

1439 Digital Input 3 Assignable Function 0 7 1 - F163 0

... Reserved

OUTPUT RELAY SETUP
1504 Trip Relay Operation 0 1 1 - F161 0

1505 Alarm Relay Operation 0 1 1 - F161 1

1506 Aux1 Relay Operation 0 1 1 - F161 1

1507 Aux2 Relay Operation 0 1 1 - F161 0

... Reserved

LOCAL RTD #1
1790 Local RTD #1 Application 0 4 1 - F121 0

1791 Local RTD #1 High Alarm 0 2 1 - F115 0

1792 Local RTD #1 High Alarm Relays 0 7 1 - F113 2

1793 Local RTD #1 High Alarm Level 1 200 1 oC F1 130

1794 Local RTD #1 Alarm 0 2 1 - F115 0

1795 Local RTD #1 Alarm Relays 0 7 1 - F113 1

1796 Local RTD #1 Alarm Level 1 200 1 oC F1 130

1797 Record RTD #1 Alarms as Events 0 1 1 - F103 0

1798 Local RTD #1 Trip 0 2 1 - F115 0

1799 Enable RTD #1 Trip Voting 0 13 1 - F122 1

179A Local RTD #1 Trip Relays 0 7 1 - F111 1

179B Local RTD #1 Trip Level 1 200 1 oC F1 130

179C Local RTD #1 RTD Type 0 3 1 - F120 0

17A0 First Character of Local RTD #1 Name 32 127 1 - F1 ’R’

↓ ↓ - - - - - -

17A3 8th Character of Local RTD #1 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #2
17B0 Local RTD #2 Application 0 4 1 - F121 0

17B1 Local RTD #2 High Alarm 0 2 1 - F115 0

17B2 Local RTD #2 High Alarm Relays 0 7 1 - F113 2

17B3 Local RTD #2 High Alarm Level 1 200 1 oC F1 130

17B4 Local RTD #2 Alarm 0 2 1 - F115 0

17B5 Local RTD #2 Alarm Relays 0 7 1 - F113 1

17B6 Local RTD #2 Alarm Level 1 200 1 oC F1 130

17B7 Record RTD #2 Alarms as Events 0 1 1 - F103 0

17B8 Local RTD #2 Trip 0 2 1 - F 115 0

17B9 Enable RTD #2 Trip Voting 0 13 1 - F122 1

17BA Local RTD #2 Trip Relays 0 7 1 - F111 1

17BB Local RTD #2 Trip Level 1 200 1 oC F1 130

17BC Local RTD #2 RTD Type 0 3 1 - F120 0

17C0 First Character of Local RTD #2 Name 32 127 1 - F1 ’R’

↓ ↓
17C3 8th Character of Local RTD #2 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #3
17D0 Local RTD #3 Application 0 4 1 - F121 0

17D1 Local RTD #3 High Alarm 0 2 1 - F115 0

17D2 Local RTD #3 High Alarm Relays 0 7 1 - F113 2

17D3 Local RTD #3 High Alarm Level 1 200 1 oC F1 130

17D4 Local RTD #3 Alarm 0 2 1 - F115 0

17D5 Local RTD #3 Alarm Relays 0 7 1 - F113 1

17D6 Local RTD #3 Alarm Level 1 200 1 oC F1 130

17D7 Record RTD #3 Alarms as Events 0 1 1 - F103 0

Table 8–1: MEMORY MAP (Sheet 6 of 11)
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17D8 Local RTD #3 Trip 0 2 1 - F115 0

17D9 Enable RTD #3 Trip Voting 0 13 1 - F122 1

17DA Local RTD #3 Trip Relays 0 7 1 - F111 1

17DB Local RTD #3 Trip Level 1 200 1 oC F1 130

17DC Local RTD #3 RTD Type 0 3 1 - F120 0

17E0 First Character of Local RTD #3 Name 32 127 1 - F1 ’R’

↓ ↓
17E3 8th Character of Local RTD #3 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #4
17F0 Local RTD #4 Application 0 4 1 - F121 0

17F1 Local RTD #4 High Alarm 0 2 1 - F115 0

17F2 Local RTD #4 High Alarm Relays 0 7 1 - F113 2

17F3 Local RTD #4 High Alarm Level 1 200 1 oC F1 130

17F4 Local RTD #4 Alarm 0 2 1 - F115 0

17F5 Local RTD #4 Alarm Relays 0 7 1 - F113 1

17F6 Local RTD #4 Alarm Level 1 200 1 oC F1 130

17F7 Enable RTD #4 Alarms as Events 0 1 1 - F103 0

17F8 Local RTD #4 Trip 0 2 1 - F115 0

17F9 Enable RTD #4 Trip Voting 0 13 1 - F122 1

17FA Local RTD #4 Trip Relays 0 7 1 - F111 1

17FB Local RTD #4 Trip Level 1 200 1 oC F1 130

17FC Local RTD #4 RTD Type 0 3 1 - F120 0

1800 First Character of Local RTD #4 Name 32 127 1 - F1 ’R’

↓ ↓
1803 8th Character of Local RTD #4 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #5
1810 Local RTD #5 Application 0 4 1 - F121 0

1811 Local RTD #5 High Alarm 0 2 1 - F115 0

1812 Local RTD #5 High Alarm Relays 0 7 1 - F113 1

1813 Local RTD #5 High Alarm Level 1 200 1 oC F1 130

1814 Local RTD #5 Alarm 0 2 1 - F115 0

1815 Local RTD #5 Alarm Relays 0 7 1 - F113 1

1816 Local RTD #5 Alarm Level 1 200 1 oC F1 130

1817 Record RTD #5 Alarms as Events 0 1 1 - F103 0

1818 Local RTD #5 Trip 0 2 1 - F115 0

1819 Enable RTD #5 Trip Voting 0 13 1 - F122 1

181A Local RTD #5 Trip Relays 0 7 1 - F111 1

181B Local RTD #5 Trip Level 1 200 1 oC F1 130

181C Local RTD #5 RTD Type 0 3 1 - F120 0

1820 First Character of Local RTD #5 Name 32 127 1 - F1 ’R’

↓ ↓
1823 8th Character of Local RTD #5 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #6
1830 Local RTD #6 Application 0 4 1 - F121 0

1831 Local RTD #6 High Alarm 0 2 1 - F115 0

1832 Local RTD #6 High Alarm Relays 0 7 1 - F113 2

1833 Local RTD #6 High Alarm Level 1 200 1 oC F1 130

1834 Local RTD #6 Alarm 0 2 1 - F115 0

1835 Local RTD #6 Alarm Relays 0 7 1 - F113 1

1836 Local RTD #6 Alarm Level 1 200 1 oC F1 130

1837 Record RTD #6 Alarms as Events 0 1 1 - F103 0

1838 Local RTD #6 Trip 0 2 1 - F115 0

1839 Enable RTD #6 Trip Voting 0 13 1 - F122 1

183A Local RTD #6 Trip Relays 0 7 1 - F111 1

183B Local RTD #6 Trip Level 1 200 1 oC F1 130

183C Local RTD #6 RTD Type 0 3 1 - F120 0

Table 8–1: MEMORY MAP (Sheet 7 of 11)
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1840 First Character of Local RTD #6 Name 32 127 1 - F1 ’R’

↓ ↓
1843 8th Character of Local RTD #6 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #7
1850 Local RTD #7 Application 0 4 1 - F121 0

1851 Local RTD #7 High Alarm 0 2 1 - F115 0

1852 Local RTD #7 High Alarm Relays 0 7 1 - F113 2

1853 Local RTD #7 High Alarm Level 1 200 1 oC F1 130

1854 Local RTD #7 Alarm 0 2 1 - F115 0

1855 Local RTD #7 Alarm Relays 0 7 1 - F113 1

1856 Local RTD #7 Alarm Level 1 200 1 oC F1 130

1857 Record RTD #7 Alarms as Events 0 1 1 - F103 0

1858 Local RTD #7 Trip 0 2 1 - F115 0

1859 Enable RTD #7 Trip Voting 0 13 1 - F122 1

185A Local RTD #7 Trip Relays 0 7 1 - F111 1

185B Local RTD #7 Trip Level 1 200 1 oC F1 130

185C Local RTD #7 RTD Type 0 3 1 - F120 0

1860 First Character of Local RTD #7 Name 32 127 1 - F1 ’R’

↓ ↓
1863 8th Character of Local RTD #7 Name 32 127 1 - F1 " "

1864 Reserved

LOCAL RTD #8
1870 Local RTD #8 Application 0 4 1 - F121 0

1871 Local RTD #8 High Alarm 0 2 1 - F115 0

1872 Local RTD #8 High Alarm Relays 0 7 1 - F113 2

1873 Local RTD #8 High Alarm Level 1 200 1 oC F1 130

1874 Local RTD #8 Alarm 0 2 1 - F115 0

1875 Local RTD #8 Alarm Relays 0 7 1 - F113 1

1876 Local RTD #8 Alarm Level 1 200 1 oC F1 130

1877 Record RTD #8 Alarms as Events 0 1 1 - F103 0

1878 Local RTD #8 Trip 0 2 1 - F115 0

1879 Enable RTD #8 Trip Voting 0 13 1 - F122 1

187A Local RTD #8 Trip Relays 0 7 1 - F111 1

187B Local RTD #8 Trip Level 1 200 1 oC F1 130

187C Local RTD #8 RTD Type 0 3 1 - F120 0

1880 First Character of Local RTD #8 Name 32 127 1 - F1 ’R’

↓ ↓
1883 8th Character of Local RTD #8 Name 32 127 1 - F1 " "

1884 Reserved

LOCAL RTD #9
1890 Local RTD #9 Application 0 4 1 - F121 0

1891 Local RTD #9 High Alarm 0 2 1 - F115 0

1892 Local RTD #9 High Alarm Relays 0 7 1 - F113 2

1893 Local RTD #9 High Alarm Level 1 200 1 oC F1 130

1894 Local RTD #9 Alarm 0 2 1 - F115 0

1895 Local RTD #9 Alarm Relays 0 7 1 - F113 1

1896 Local RTD #9 Alarm Level 1 200 1 oC F1 130

1897 Record RTD #9 Alarms as Events 0 1 1 - F103 0

1898 Local RTD #9 Trip 0 2 1 - F115 0

1899 Enable RTD #9 Trip Voting 0 13 1 - F122 1

189A Local RTD #9 Trip Relays 0 7 1 - F111 1

189B Local RTD #9 Trip Level 1 200 1 oC F1 130

189C Local RTD #9 RTD Type 0 3 1 - F120 0

18A0 First Character of Local RTD #9 Name 32 127 1 - F1 ’R’

↓ ↓
18A3 8th Character of Local RTD #9 Name 32 127 1 - F1 " "

18A4 Reserved

Table 8–1: MEMORY MAP (Sheet 8 of 11)
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LOCAL RTD #10
18B0 Local RTD #10 Application 0 4 1 - F121 0

18B1 Local RTD #10 High Alarm 0 2 1 - F115 0

18B2 Local RTD #10 High Alarm Relays 0 7 1 - F113 2

18B3 Local RTD #10 High Alarm Level 1 200 1 oC F1 130

18B4 Local RTD #10 Alarm 0 2 1 - F115 0

18B5 Local RTD #10 Alarm Relays 0 7 1 - F113 1

18B6 Local RTD #10 Alarm Level 1 200 1 oC F1 130

18B7 Record RTD #10 Alarms as Events 0 1 1 - F103 0

18B8 Local RTD #10 Trip 0 2 1 - F115 0

18B9 Enable RTD #10 Trip Voting 0 13 1 - F122 1

18BA Local RTD #10 Trip Relays 0 7 1 - F111 1

18BB Local RTD #10 Trip Level 1 200 1 oC F1 130

18BC Local RTD #10 RTD Type 0 3 1 - F120 0

18C0 First Character of Local RTD #10 Name 32 127 1 - F1 ’R’

↓ ↓
18C3 8th Character of RTD #10 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #11
18D0 Local RTD #11 Application 0 4 1 - F121 0

18D1 Local RTD #11 High Alarm 0 2 1 - F115 0

18D2 Local RTD #11 High Alarm Relays 0 7 1 - F113 2

18D3 Local RTD #11 High Alarm Level 1 200 1 oC F1 130

18D4 Local RTD #11 Alarm 0 2 1 - F115 0

18D5 Local RTD #11 Alarm Relays 0 7 1 - F113 1

18D6 Local RTD #11 Alarm Level 1 200 1 oC F1 130

18D7 Record RTD #11 Alarm Events 0 1 1 - F103 0

18D8 Local RTD #11 Trip 0 2 1 - F115 0

18D9 Enable RTD #11 Trip Voting 0 13 1 - F122 1

18DA Local RTD #11 Trip Relays 0 7 1 - F111 1

18DB Local RTD #11 Trip Level 1 200 1 oC F1 130

18DC Local RTD #11 RTD Type 0 3 1 - F120 0

18E0 First Character of Local RTD #11 Name 32 127 1 - F1 ’R’

↓ ↓
18E3 8th Character of Local RTD #11 Name 32 127 1 - F1 " "

... Reserved

LOCAL RTD #12
18F0 Local RTD #12 Application 0 4 1 - F121 0

18F1 Local RTD #12 High Alarm 0 2 1 - F115 0

18F2 Local RTD #12 High Alarm Relays 0 7 1 - F113 2

18F3 Local RTD #12 High Alarm Level 1 200 1 oC F1 130

18F4 Local RTD #12 Alarm 0 2 1 - F115 0

18F5 Local RTD #12 Alarm Relays 0 7 1 - F113 1

18F6 Local RTD #12 Alarm Level 1 200 1 oC F1 130

18F7 Record RTD #12 Alarms as Events 0 1 1 - F103 0

18F8 Local RTD #12 Trip 0 2 1 - F115 0

18F9 Enable RTD #12 Trip Voting 0 13 1 - F122 1

18FA Local RTD #12 Trip Relays 0 7 1 - F111 1

18FB Local RTD #12 Trip Level 1 200 1 oC F1 130

18FC Local RTD #12 RTD Type 0 3 1 - F120 0

1900 First Character of Local RTD #12 Name 32 127 1 - F1 ’R’

↓ ↓
1903 8th Character of Local RTD #12 Name 32 127 1 - F1 " "

... Reserved

OPEN RTD ALARM
1B20 Open RTD Alarm 0 2 1 - F115 0

1B21 Assign Alarm Relays 0 7 1 - F113 1

1B22 Open RTD Alarm Events 0 1 1 - F103 0

Table 8–1: MEMORY MAP (Sheet 9 of 11)
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SHORT/LOW TEMPERATURE RTD ALARM
1B23 Short / Low Temp RTD Alarm 0 2 1 - F115 0

1B24 Assign Alarm Relays 0 7 1 - F113 1

1B25 Short / Low Temp Alarm Events 0 1 1 - F103 0

... Reserved - - - - - -

TRIP COUNTER
1C80 Trip Counter Alarm 0 2 1 - F115 0

1C81 Assign Alarm Relays 0 7 1 - F113 1

1C82 Alarm Pickup Level 0 50000 1 - F1 25

1C83 Trip Counter Alarm Events 0 1 1 - F103 0

... Reserved

ANALOG OUTPUTS
1D40 Enable Analog Output 1 0 1 1 - F103 0

1D41 Assign Analog Output 1 Output Range 0 2 1 - F26 0

1D42 Assign Analog Output 1 Parameter 0 111 1 - F127 0

1D43 Analog Output 1 Minimum TBD TBD 1 - F1 0

1D44 Analog Output 1 Maximum TBD TBD 1 - F1 0

1D45 Enable Analog Output 2 0 1 1 - F103 0

1D46 Assign Analog Output 2 Output Range 0 2 1 - F26 0

1D47 Assign Analog Output 2 Parameter 0 111 1 - F127 0

1D48 Analog Output 2 Minimum TBD TBD 1 - F1 0

1D49 Analog Output 2 Maximum TBD TBD 1 - F1 0

1D4A Enable Analog Output 3 0 1 1 - F103 0

1D4B Assign Analog Output 3 Output Range 0 2 1 - F26 0

1D4C Assign Analog Output 3 Parameter 0 111 1 - F127 0

1D4D Analog Output 3 Minimum TBD TBD 1 - F1 0

1D4E Analog Output 3 Maximum TBD TBD 1 - F1 0

1D4F Enable Analog Output 4 0 1 1 - F103 0

1D50 Assign Analog Output 4 Output Range 0 2 1 - F26 0

1D51 Assign Analog Output 4 Parameter 0 111 1 - F127 0

1D52 Analog Output 4 Minimum TBD TBD 1 - F1 0

1D53 Analog Output 4 Maximum TBD TBD 1 - F1 0

... Reserved

TEST OUTPUT RELAYS (0 = continuous)
1F80 Force Trip Relay 0 2 1 - F150 0

1F81 Force Trip Relay Duration 1 300 1 s F1 0

1F82 Force AUX1 Relay 0 2 1 - F150 0

1F83 Force AUX1 Relay Duration 1 300 1 s F1 0

1F84 Force AUX2 Relay 0 2 1 - F150 0

1F85 Force AUX2 Relay Duration 1 300 1 s F1 0

1F86 Force Alarm Relay 0 2 1 - F150 0

1F87 Force Alarm Relay Range 1 300 1 s F1 0

... Reserved

TEST ANALOG OUTPUTS
1F90 Force Analog Outputs 0 1 1 - F126 0

1F91 Analog Output 1 Forced Value 0 100 1 % range F1 0

1F92 Analog Output 2 Forced Value 0 100 1 % range F1 0

1F93 Analog Output 3 Forced Value 0 100 1 % range F1 0

1F94 Analog Output 4 Forced Value 0 100 1 % range F1 0

... Reserved

EVENT RECORDER / TRACE MEMORY (ADDRESSES 3000 TO 3FFF)
EVENT RECORDER

3000 Event Recorder Last Reset (2 words) N/A N/A N/A N/A F18 N/A

3002 Total Number of Events Since Last Clear 0 65535 1 N/A F1 0

3003 Event Record Selector (1=oldest, 40=newest) 1 40 1 N/A F1 1

3004 Cause of Event 0 40 1 - F134 0

3005 Time of Event (2 words) N/A N/A N/A N/A F19 N/A

3007 Date of Event (2 words) N/A N/A N/A N/A F18 N/A

3009 Reserved - - - - - -

Table 8–1: MEMORY MAP (Sheet 10 of 11)
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3012 Event Hottest Stator RTD 0 12 1 - F1 0

3013 Event Temperature of Hottest Stator RTD -40 200 1 °C F4 0

... Reserved - - - - - -

Table 8–1: MEMORY MAP (Sheet 11 of 11)
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8.3.4 MEMORY MAP DATA FORMATS

Table 8–2: MEMORY MAP DATA FORMATS (Sheet 1 of 5)
CODE TYPE DEFINITION

F1 16 bits UNSIGNED VALUE
Example: 1234 stored as 1234

F2 16 bits UNSIGNED VALUE, 1 DECIMAL PLACE
Example: 123.4 stored as 1234

F3 16 bits UNSIGNED VALUE, 2 DECIMAL PLACES
Example: 12.34 stored as 1234

F4 16 bits 2’s COMPLEMENT SIGNED VALUE
Example: -1234 stored as -1234 (i.e. 64302)

F5 16 bits 2’s COMPLEMENT SIGNED VALUE, 1 DECIMAL PLACES
Example: -123.4 stored as -1234 (i.e. 64302)

F6 16 bits 2’s COMPLEMENT SIGNED VALUE, 2 DECIMAL PLACES
Example: -12.34 stored as -1234 (i.e. 64302)

F7 16 bits 2’s COMPLEMENT SIGNED VALUE, 3 DECIMAL PLACES
Example: -1.234 stored as -1234 (i.e. 64302)

F8 16 bits 2’s COMPLEMENT SIGNED VALUE, 4 DECIMAL PLACES
Example: -0.1234 stored as -1234 (i.e. 64302)

F15 16 bits HARDWARE REVISION

0000 0000 0000 0001 1 = A

0000 0000 0000 0010 2 = B

↓ ↓

0000 0000 0001 1010 26 = Z

F16 16 bits SOFTWARE REVISION

1111 1111 xxxx xxxx Major Revision Number, 0 to 9 in steps of 1

xxxx xxxx 1111 1111 Minor Revision Number (two BCD digits), 00 to 99 in steps of 1
Example: Revision 2.30 stored as 0230 hex

F18 32 bits DATE (MM/DD/YYYY)
Example: Feb. 20, 1995 stored as 34867142 (i.e. 1st word: 0214, 2nd word 07C6)

1st byte Month (1 to 12)

2nd byte Day (1 to 31)

3rd and 4th byte Year (1998 to 2094)

F19 32 bits TIME (HH:MM:SS:hh)
Example: 2:05pm stored as 235208704 (i.e. 1st word: 0E05, 2nd word 0000)

1st byte Hours (0 to 23)

2nd byte Minutes (0 to 59)

3rd byte Seconds (0 to 59)

4th byte Hundreds of seconds (0 to 99) - Not used by 369

F22 16 bits TWO 8-BIT CHARACTERS PACKED INTO 16-BIT UNSIGNED
Example: String "AB" stored as 4142 hex.

MSB First Character

LSB Second Character

F26 16 Bits ANALOG OUTPUT SELECTION

0 0 - 1mA

1 0 - 20 mA

2 4 - 20 mA

F31 16 Bits COMMAND FUNCTION CODES

0 Not in use

1 Reset RRTD

... Reserved

6 Clear Trip Counters

7 Clear Last Trip Date

... Reserved

10 Clear RTD Maximums

F100 Unsigned 16 bit integer TEMPERATURE DISPLAY UNITS

0 Celsius

1 Fahrenheitw . 
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F101 Unsigned 16 bit integer RS485 BAUD RATE

0 1200 baud

1 2400 baud

2 4800 baud

3 9600 baud

4 19200 baud

F102 Unsigned 16 bit integer RS485 PARITY

0 None

1 Odd

2 Even

F103 Unsigned 16 bit integer OFF/ON OR NO/YES SELECTION

0 Off / No

1 On / Yes

F111 Unsigned 16 bit integer TRIP RELAYS

0 none

1 Trip

2 Aux1

3 Aux2

4 Trip & Aux1

5 Trip & Aux2

6 Aux1 & Aux2

7 Trip & Aux1 & Aux2

F112 Unsigned 16 bit integer NOT DEFINED

0

1

F113 Unsigned 16 bit integer ALARM RELAYS

0 None

1 Alarm

2 Aux1

3 Aux2

4 Alarm & Aux1

5 Alarm & Aux2

6 Aux1 & Aux2

7 Alarm & Aux1 & Aux2

F114 Unsigned 16 bit integer COUNTER TYPE

0 Increment

1 Decrement

F115 Unsigned 16 bit integer ALARM/TRIP TYPE SELECTION

0 Off

1 Latched

2 Unlatched

F116 Unsigned 16 bit integer SWITCH TYPE

0 Normally Open

1 Normally Closed

F119 Unsigned 16 bit integer BACKUP RELAYS

0 None

1 Aux 1

2 Aux1 & Aux2

3 Aux2

F120 Unsigned 16 bit integer RTD TYPE

0 100 Ohm Platinum

1 120 Ohm Nickel

2 100 Ohm Nickel

3 10 Ohm Copper

Table 8–2: MEMORY MAP DATA FORMATS (Sheet 2 of 5)
CODE TYPE DEFINITION
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F121 Unsigned 16 bit integer RTD APPLICATION

0 None

1 Stator

2 Bearing

3 Ambient

4 Other

F122 Unsigned 16 bit integer LOCAL/REMOTE RTD VOTING SELECTION

0 Off

1 RTD #1

2 RTD #2

3 RTD #3

4 RTD #4

5 RTD #5

6 RTD #6

7 RTD #7

8 RTD #8

9 RTD #9

10 RTD #10

11 RTD #11

12 RTD #12

13 All Stator

F123 Unsigned 16 bit integer ALARM STATUS

0 Off

1 Not Active

2 Timing Out

3 Active

4 Latched

F127 Unsigned 16 bit integer ANALOG OUTPUT PARAMETER SELECTION

0 to 11 Reserved

12 Hottest Stator RTD

13 Local RTD #1

14 Local RTD #2

15 Local RTD #3

16 Local RTD #4

17 Local RTD #5

18 Local RTD #6

19 Local RTD #7

20 Local RTD #8

21 Local RTD #9

22 Local RTD #10

23 Local RTD #11

24 Local RTD #12

F130 Unsigned 16 bit integer DIGITAL INPUT PICKUP TYPE

0 Over

1 Under

F131 Unsigned 16 bit integer INPUT SWITCH STATUS

0 Open

1 Closed

F134 Unsigned 16 bit integer CAUSE OF EVENT

0 No Event

1 to 4 Resolved

5 Digital Input 6 Trip

6 Digital Input 2 Trip

7 Digital Input 5 Trip

Table 8–2: MEMORY MAP DATA FORMATS (Sheet 3 of 5)
CODE TYPE DEFINITION
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F134
ctd.

8 Digital Input 4 Trip

9 Digital Input 1 Trip

10 Digital Input 3 Trip

11 to 40 Reserved

41 Local RTD1 Trip

42 Local RTD2 Trip

43 Local RTD3 Trip

44 Local RTD4 Trip

45 Local RTD5 Trip

46 Local RTD6 Trip

47 Local RTD7 Trip

48 Local RTD8 Trip

49 Local RTD9 Trip

50 Local RTD10 Trip

51 Local RTD11 Trip

52 Local RTD12 Trip

53 to 66 Reserved

67 Digital Input 6 Alarm

68 Digital Input 2 Alarm

69 Digital Input 5 Alarm

70 Digital Input 4 Alarm

71 Digital Input 1 Alarm

72 Digital Input 3 Alarm

73 to 91 Reserved

92 Local RTD1 Alarm

93 Local RTD2 Alarm

94 Local RTD3 Alarm

95 Local RTD4 Alarm

96 Local RTD5 Alarm

97 Local RTD6 Alarm

98 Local RTD7 Alarm

99 Local RTD8 Alarm

100 Local RTD9 Alarm

101 Local RTD10 Alarm

102 Local RTD11 Alarm

103 Local RTD12 Alarm

104 Local RTD1 Hi Alarm

105 Local RTD2 Hi Alarm

106 Local RTD3 Hi Alarm

107 Local RTD4 Hi Alarm

108 Local RTD5 Hi Alarm

109 Local RTD6 Hi Alarm

110 Local RTD7 Hi Alarm

111 Local RTD8 Hi Alarm

112 Local RTD9 Hi Alarm

113 Local RTD10 Hi Alarm

114 RTD11 Hi Alarm

115 RTD12 Hi Alarm

116 to 141 Reserved

142 Open RTD Alarm

143 Lost RRTD Comm Alarm

Table 8–2: MEMORY MAP DATA FORMATS (Sheet 4 of 5)
CODE TYPE DEFINITION
w . 

El
ec

tric
alP

ar
tM

an
ua

ls 
. c

o

GE Multilin RRTD Remote RTD Module 8-23

w



8.3 MEMORY MAP 8 COMMUNICATIONS

8

w

om
F134
ctd.

144 Short/Low RTD Alarm

145 Trip Counter Alarm

146 to 150 Reserved

151 Digital Counter Alarm

152 Service Alarm

153 Control Power Lost

154 Control Power App

155 to 272 Reserved

273 Power Failure

274 Software Reset

275 Clock Failure

276 A/D Failure

F141 Unsigned 16 bit integer OUTPUT RELAY STATUS

bit 0 Trip

bit 1 Alarm

bit 2 Auxiliary 1

bit 3 Auxiliary 2

F149 Unsigned 16 Bit Integer CHANNEL 3 APPLICATION

0 MODBUS

1 Remote RTD 

F150 Unsigned 16 Bit Integer OUTPUT RELAY STATUS

0 De - Energized

1 Energized

F151 Unsigned 16 Bit Integer CHANNEL TYPE

0 RS 485

1 Fiber Optic

F156 Unsigned 16 Bit Integer REMOTE RTD COMMUNICATION STATUS

0 Remote RTD Module Communication Lost

1 Remote RTD Communication on Line

F161 Unsigned 16 Bit Integer OUTPUT RELAY FAILSAFE CODE

0 Failsafe

1 Non Failsafe

F162 Unsigned 16 Bit Integer ACCESS LEVEL

0 Read Only

1 Read / Write

2 Factory Service

F163 Unsigned 16 Bit Integer RRTD DIGITAL INPUT FUNCTION

0 Off

1 undefined

2 General Switch

3 Digital Counter

Table 8–2: MEMORY MAP DATA FORMATS (Sheet 5 of 5)
CODE TYPE DEFINITION
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APPENDIX A A.1 WARRANTY INFORMATION

A

w

m
APPENDIX A WARRANTYA.1 WARRANTY INFORMATION

GE MULTILIN RELAY WARRANTY

General Electric Multilin (GE Multilin) warrants each relay it manufac-
tures to be free from defects in material and workmanship under nor-
mal use and service for a period of 24 months from date of shipment
from factory.

In the event of a failure covered by warranty, GE Multilin will undertake
to repair or replace the relay providing the warrantor determined that it
is defective and it is returned with all transportation charges prepaid to
an authorized service centre or the factory. Repairs or replacement
under warranty will be made without charge.

Warranty shall not apply to any relay which has been subject to mis-
use, negligence, accident, incorrect installation or use not in accor-
dance with instructions nor any unit that has been altered outside a GE
Multilin authorized factory outlet.

GE Multilin is not liable for special, indirect or consequential damages
or for loss of profit or for expenses sustained as a result of a relay mal-
function, incorrect application or adjustment.

For complete text of Warranty (including limitations and disclaimers),
refer to GE Multilin Standard Conditions of Sale.
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